APEX2

Version 2

USER MANUAL
This document covers the APEX2 software program. References to this document should be shown as M86-Exx078 APEX2 User Manual.

© 2006 Bruker AXS Inc., 5465 East Cheryl Parkway, Madison, WI 53711. All world rights reserved.

Notice
The information in this publication is provided for reference only. All information contained in this publication is believed to be correct and complete. Bruker AXS Inc. shall not be liable for errors contained herein, nor for incidental or consequential damages in conjunction with the furnishing, performance, or use of this material. All product specifications, as well as the information contained in this publication, are subject to change without notice.

This publication may contain or reference information and products protected by copyrights or patents and does not convey any license under the patent rights of Bruker AXS Inc. nor the rights of others. Bruker AXS Inc. does not assume any liabilities arising out of any infringements of patents or other rights of third parties. Bruker AXS Inc. makes no warranty of any kind with regard to this material, including but not limited to the implied warranties of merchantability and fitness for a particular purpose.

No part of this publication may be stored in a retrieval system, transmitted, or reproduced in any way, including but not limited to photocopy, photography, magnetic, or other record without prior written permission of Bruker AXS Inc.

Address comments to: Technical Publications Department
Bruker AXS Inc.
5465 East Cheryl Parkway
Madison, Wisconsin 53711-5373
USA

All trademarks and registered trademarks are the sole property of their respective owners.

Printed in the U.S.A.

Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2/05</td>
<td>Original release.</td>
</tr>
<tr>
<td>1</td>
<td>6/06</td>
<td>Revised and expanded for APEX2 Version 2.</td>
</tr>
</tbody>
</table>
Table of Contents

1 About This User Manual ............................................................. 1-1
  1.1 APEX II Systems for Chemical Crystallography .......................... 1-1
  1.2 Terms and Conventions Used in this User Manual ....................... 1-2
    1.2.1 Typographical Conventions ........................................... 1-2
    1.2.2 Equivalent Terms ...................................................... 1-2
    1.2.3 Warnings, Cautions, and Notes ....................................... 1-3
  1.3 Referenced Documentation ..................................................... 1-3
  1.4 X-ray Safety ................................................................. 1-4
  1.5 APEX2 Help and Technical Support .......................................... 1-4
    1.5.1 The “What’s This?” Function ......................................... 1-4
    1.5.2 Technical Support ....................................................... 1-5

2 Hardware Overview ............................................................... 2-1
  2.1 System Components ........................................................... 2-1
    2.1.1 APEX II Detector ....................................................... 2-3
    2.1.2 Goniometer ............................................................. 2-3
    2.1.3 Radiation Safety Enclosure with Interlocks and Warning Lights .... 2-8
    2.1.4 D8 Controller .......................................................... 2-8
3 Software Overview .......................................................... 3-1
   3.1 Introduction to Client and Server Functions .......................... 3-1
   3.2 Server Functions ....................................................... 3-3
      3.2.1 APEX2Server ..................................................... 3-3
      3.2.2 Bruker Instrument Service (BIS) ............................... 3-4
   3.3 Client Functions ...................................................... 3-5
      3.3.1 APEX2 Program ................................................... 3-5
      3.3.2 Bruker Configuration Program (BCP) ......................... 3-5
      3.3.3 The Sample Database ........................................... 3-6
   3.4 The APEX2 GUI .......................................................... 3-7
      3.4.1 Title Bar .......................................................... 3-8
      3.4.2 Menu Bar ........................................................ 3-8
      3.4.3 Tool Icon Bar ................................................... 3-11
      3.4.4 Task Bar ........................................................ 3-12
      3.4.5 Task Display Area ............................................. 3-16

4 Program Startup and Shutdown ............................................ 4-1
   4.1 Access to BCP and APEX2 ............................................ 4-2
   4.2 Online and Offline Operation ....................................... 4-2
   4.3 Startup ..................................................................... 4-3
      4.3.1 Starting Bruker Instrument Service (BIS) .................... 4-3
      4.3.2 Starting APEX2 .................................................. 4-3
   4.4 License Considerations ................................................ 4-5
4.5 **Shutdown** .......................... 4-6
   4.5.1 Shutting Down APEX2 .......................... 4-6
   4.5.2 Shutting Down BIS .......................... 4-6

5 **Crystal Centering and Screening** .................. 5-1
   5.1 Start APEX2Server .......................... 5-1
   5.2 Mount the Goniometer Head on the Instrument .......................... 5-2
   5.3 Center the Crystal .......................... 5-6
      5.3.1 For Kappa APEX II Systems .......................... 5-7
      5.3.2 For SMART APEX II Systems .......................... 5-13
   5.4 Simple Scans .......................... 5-18
   5.5 Examples of Poor Quality Crystals .......................... 5-22

6 **Data Collection** .......................... 6-1
   6.1 Create a New Sample .......................... 6-2
   6.2 Determine the Unit Cell .......................... 6-4
      6.2.1 Automatic Mode .......................... 6-6
      6.2.2 Manual Mode .......................... 6-7
   6.3 Determine the Data Collection Strategy .......................... 6-16
      6.3.1 Operation and Initial Settings .......................... 6-16
      6.3.2 Refining the Strategy .......................... 6-18
      6.3.3 Looking at the Current Strategy .......................... 6-21
   6.4 Data Collection/Run Experiment .......................... 6-23

7 **Data Integration and Scaling** .......................... 7-1
7.1 Integration ................................................................. 7-2  
  7.1.1 Check the Refinement Defaults ........................................... 7-5  
  7.1.2 Check the Integration Options ........................................... 7-6  
  7.1.3 Start Integration ......................................................... 7-7  

7.2 SaintChart ................................................................. 7-8  
  7.2.1 Monitor the Progress of the Integration ................................ 7-9  
  7.2.2 Examine Final Results .................................................. 7-11  

7.3 Scale Data ................................................................. 7-14  
  7.3.1 Set Up Input Files ....................................................... 7-14  
  7.3.2 Parameter Refinement ................................................... 7-15  
  7.3.3 Error Model Refinement ............................................... 7-16  
  7.3.4 Examine Diagnostics ................................................... 7-17  
  7.3.5 Exit ........................................................................... 7-21  

8 Examine Data ................................................................. 8-1  
  8.1 Space Group Determination With XPREP ................................. 8-1  
    8.1.1 Determining Space Groups ............................................. 8-2  
    8.1.2 Reflection Statistics .................................................... 8-4  
    8.1.3 Preparing an Output File .............................................. 8-5  
  8.2 Simulated Precession Images ................................................. 8-7  

9 Structure Solution and Refinement ........................................ 9-1  
  9.1 Overview ........................................................................ 9-1  
  9.2 Solve the Structure .......................................................... 9-2  
    9.2.1 Options for Direct Methods ........................................... 9-3  
    9.2.2 Options for Dual Space Methods .................................... 9-4  
    9.2.3 Options for Patterson Methods ...................................... 9-4  
  9.3 Refine the Structure with XShell .......................................... 9-5
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.3.1 Label the Atoms</td>
<td>9-10</td>
</tr>
<tr>
<td>9.3.2 Refine the Model</td>
<td>9-13</td>
</tr>
<tr>
<td>9.3.3 View Atomic Displacement Parameters (Thermal Ellipsoids)</td>
<td>9-16</td>
</tr>
<tr>
<td>9.3.4 Sort Atoms</td>
<td>9-18</td>
</tr>
<tr>
<td>9.3.5 Add Hydrogen Atoms</td>
<td>9-20</td>
</tr>
<tr>
<td>9.3.6 Final Refinement for Publication</td>
<td>9-23</td>
</tr>
<tr>
<td>9.3.7 Generate an Atomic Displacement (Thermal Ellipsoid) Plot</td>
<td>9-24</td>
</tr>
</tbody>
</table>

**Appendix A  RLATT**  
A.1 Open RLATT  
A.2 Orienting Views  
A.3 Defining Groups  
A.4 Measuring Distances and Angles  
A.5 Writing a .p4p File

**Appendix B  Face Indexing**  
B.1 Start the Crystal Faces Module  
B.2 Collect a Video Zip Stream  
B.3 Using the Face Indexing Module  
  B.3.1 Set View Options  
  B.3.2 Specify Crystal Faces  
  B.3.3 Editing the Face List  
B.4 Scaling With Face Indices

**Appendix C  Using CELL_NOW**
C.1 Running CELL_NOW ................................................................. C-1
C.2 CELL_NOW output ................................................................. C-9

Appendix D Configuring APEX2 .............................................. D-1
D.1 Global, User, and Sample-specific Variables ......................... D-1
D.2 Python Code Examples ....................................................... D-1

Index ............................................................... Index-1
1 About This User Manual

1.1 APEX II Systems for Chemical Crystallography

Bruker AXS Kappa APEX II and SMART APEX II systems are the newest members in the Bruker AXS product line of instrumentation for single crystal X-ray diffraction. These systems provide the tools for complete small molecule structure determination.

The APEX2 software features a redesigned start-to-finish graphical user interface (GUI) along with the optional Phase ID and AutoStructure software modules. The Auto-Structure module simplifies structure determination more than ever before.

The hardware features the APEX II CCD detector (with four-port readout of a 4096x4096 CCD chip), radiation safety enclosure system, and a choice of two goniometers.

The Kappa APEX II system features the Kappa 4-axis goniometer.

The SMART APEX II system is an enhanced version of the SMART APEX fixed-chi system.

This User Manual and associated YLID test data are intended to provide you with a step-by-step guide to data collection and processing using the APEX2 software program.

The test data supplied was collected on a Kappa APEX II diffractometer with graphite-monochromated molybdenum radiation from a sealed tube generator. The high-quality (0.75 Å resolution) data allows easy refinement of the hydrogen atom positions and determination of the absolute structure of the crystal.
1.2 Terms and Conventions Used in this User Manual

Before using this User Manual, it is important to understand the terms and typographical conventions used. Certain kinds of formatting in the User Manual’s text are used to identify special kinds of information.

1.2.1 Typographical Conventions

Table 1.1 shows typographical conventions used to help you quickly locate and identify information in this User Manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Software interface elements (such as icons, menu items, and buttons) to be selected as part of the current procedure.</td>
</tr>
<tr>
<td><em>italics</em></td>
<td>New terms and words requiring emphasis.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Information read from or entered into a command prompt.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Navigation through a hierarchical menu. For example, “Select Start &gt; Programs &gt; Bruker AXS &gt; APEX2” describes navigating Windows’ menus from Start to Programs to Bruker AXS to APEX2.</td>
</tr>
<tr>
<td>[square brackets]</td>
<td>Keyboard input.</td>
</tr>
</tbody>
</table>

Table 1.1 – Typographical conventions

1.2.2 Equivalent Terms

Frame/Image

In this User Manual, the terms “frame” and “image” are used interchangeably to describe two-dimensional X-ray data, whether read from the CCD camera or generated within APEX2.

Greek and Roman Text

This User Manual uses scientific terminology that may be rendered in Greek text. However, this User Manual follows a convention of using Roman text to the greatest extent possible.

<table>
<thead>
<tr>
<th>Greek</th>
<th>Roman</th>
</tr>
</thead>
<tbody>
<tr>
<td>2θ</td>
<td>2-theta</td>
</tr>
<tr>
<td>θ₁</td>
<td>theta1</td>
</tr>
<tr>
<td>θ₂</td>
<td>theta2</td>
</tr>
<tr>
<td>ω</td>
<td>omega</td>
</tr>
<tr>
<td>ϕ</td>
<td>phi</td>
</tr>
<tr>
<td>χ</td>
<td>chi</td>
</tr>
<tr>
<td>γ</td>
<td>gamma</td>
</tr>
</tbody>
</table>

Table 1.2 – Greek and Roman text
1.2.3 Warnings, Cautions, and Notes

This User Manual contains notices that you must observe to ensure your own personal safety, as well as to protect the product and connected equipment. These notices are highlighted in the User Manual by a warning triangle and are marked as follows according to the level of danger.

⚠️ WARNING
The word “WARNING” alerts the reader to an immediate or potential hazard that can result in death, severe personal injury, or substantial property damage.

⚠️ CAUTION
The word “CAUTION” alerts the reader to a potential practice or condition that could result in minor personal injury or damage to the product or property.

NOTE: The word “NOTE” in bold capital letters draws your attention to particularly important information on the product or handling of the product, or to a particular part of the product documentation.

1.3 Referenced Documentation

Table 1.3 contains a list of documentation referenced in this User Manual. It is recommended to have this additional documentation available as you work with this User Manual.

<table>
<thead>
<tr>
<th>Documentation Part Number</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>269-0175xx</td>
<td>SAINT Software Reference Manual</td>
</tr>
<tr>
<td>M86-Exx024</td>
<td>Microscope Focus and Sample Alignment</td>
</tr>
<tr>
<td>M86-Exx043</td>
<td>BCP and BIS Installation Notes</td>
</tr>
<tr>
<td>M86-Exx045</td>
<td>RLATT User Manual</td>
</tr>
<tr>
<td>M86-Exx087</td>
<td>APEX2 and PROTEUM2 Installation Notes</td>
</tr>
<tr>
<td>M86-Exx092</td>
<td>User Manager User Manual</td>
</tr>
<tr>
<td>M88-Exx099</td>
<td>License Manager User Manual</td>
</tr>
</tbody>
</table>

Table 1.3 – Referenced Documentation
1.4 X-ray Safety

**WARNING**

X-ray equipment produces potentially harmful radiation and can be dangerous to anyone in the equipment's vicinity unless safety precautions are completely understood and implemented. All persons designated to operate or perform maintenance on this instrument need to be fully trained on the nature of radiation, X-ray generating equipment, and radiation safety. All users of the X-ray equipment are required to accurately monitor their exposure to X-rays by proper use of X-ray dosimeters.

For safety issues related to operation and maintenance of your particular X-ray generator, diffractometer, and shield enclosure, please refer to the manufacturer's operation manuals or to your Radiation Safety Officer. The user is responsible for compliance with local safety regulations.

1.5 APEX2 Help and Technical Support

1.5.1 The “What’s This?” Function

Context-based help is available at any time within APEX2 by simply clicking the “What's This?” icon:

![Figure 1.1 – “What's This?” icon](image)

After clicking the icon, click any window, control, or field within APEX2 to obtain detailed help in a pop-up window.
1.5.2 Technical Support

Users are invited to contact Bruker AXS whenever there are problems or questions related to the system. Before contacting Bruker AXS, please:

- If there is a software problem, determine the version of the program.
- Record any error messages.
- Determine conditions and steps that recreate the problem.

If the instrument is in North America, contact our North American Service Center:

Bruker AXS Inc
Customer Support
5465 E Cheryl Pkwy
Madison, WI 53711-5373
U.S.A.

Phone No: +1 (608) 276-3087
Toll-free: 1 (800) 234-9729
Fax No: +1 (608) 276-3015
E-mail: Customer.Service@bruker-axs.com
Internet: www.bruker-axs.com

If the instrument is outside North America, contact your local Bruker AXS Service Center.
2 Hardware Overview

APEX II systems share common hardware components with other Bruker AXS products. Other members of this new generation of instruments include the D8 ADVANCE, D8 DISCOVER, and D8 GADDS systems for general diffraction. Documentation on some of these common hardware and software components is available in the User Manuals for the D8 family of instruments.

The two hardware platforms for the APEX II systems are the Kappa APEX II (the four-axis advanced research instrument) and the SMART APEX II (the three-axis laboratory instrument). Software functionality is essentially the same for both platforms.

2.1 System Components

The system (Figure 2.1 and Figure 2.2) consists of the following basic components.

- APEX II CCD detector
- 4-axis Kappa or 3-axis SMART goniometer
- K780 X-ray generator
- Radiation safety enclosure with interlocks and warning lights
- D8 controller
- Refrigerated recirculator for the detector
- Instrument control (BIS) and crystallographic software (APEX2) computer
- Video microscope
- Optional Accessories (low- and high-temperature devices)
For both SMART APEX II and Kappa APEX II systems, this external computer runs BIS, APEX2Server and APEX2, combining Client and Server functionality into a single computer.
2.1.1 APEX II Detector
The APEX II detector is specific to this system. Status lamps on the top of the detector housing indicate when the detector is on (green) and off (red).

On Kappa APEX II systems, the detector is mounted on a motorized DX track. The camera distance is computer-controlled (a typical distance for the camera is 60 mm).

On SMART APEX II systems, the detector is mounted on a DX dovetail track. The track has a scale that is calibrated in mm to indicate the distance from the crystal to the detector face (a typical distance is 60 mm). The detector distance has to be changed manually.

An optional motorized DX track is available for the SMART APEX II.

2.1.2 Goniometer
The goniometer module and APEX II detector make up the unique hardware of the system. This is the part of the instrument that actually performs the experiment.

Several components make up the goniometer module with APEX II detector:
- Goniometer (3-axis or 4-axis)
- APEX II detector
- X-ray source (including shielded X-ray tube, X-ray safety shutter, and graphite crystal monochromator)
- K780 X-ray generator
- Timing shutter and incident beam collimator (with beamstop)
- Video microscope
Kappa APEX II Goniometer

The Kappa APEX II system uses a horizontally-oriented Kappa goniometer with 2-theta, omega, kappa and phi drives and a motorized DX track for setting the detector distance. It includes mounting points for the video microscope and for optional attachments such as the optional low-temperature attachment.

With the kappa angle, the crystal can be oriented at chi from \(-92^\circ\) to \(92^\circ\). This leaves the top of the instrument open for easy access. Kappa can be positioned so that the phi drive, which has unlimited rotation, can be swung under the incident beam collimator, allowing free rotation in omega.
SMART APEX II Goniometer

The SMART APEX II system uses a horizontally-oriented D8 goniometer base with 2-theta, omega and phi drives, dovetail tracks for the X-ray source and detector, and an additional mounting ring for accessories such as the video microscope and optional low-temperature attachment.

The 3-axis system incorporates a fixed-chi stage with a chi angle of approximately 54.74° and a phi drive with 360° rotation, which is so compact that it swings under the incident beam collimator, allowing free rotation in omega.

Figure 2.4 – SMART goniometer components
X-ray Source

Three components make up the X-ray source: a shielded X-ray tube, an X-ray safety shutter, and a graphite crystal monochromator.

The sealed-tube X-ray source produces the X-ray beam used by the system.

The X-ray safety shutter is built into the X-ray tube shield. The shutter opens upon initiation of a set of exposures and closes upon the end of collection. Status lamps on the shutter housing indicate when the shutter is open (red) or closed (green). The shutter is also interfaced to the controller and to the safety interlocks.

A tunable graphite crystal monochromator selects only the $K_{\alpha}$ line ($\lambda_{\text{avg}} = 0.710730$ Å for Mo radiation, $\lambda_{\text{avg}} = 1.541838$ Å for Cu radiation) emitted from the X-ray source and passes it down the collimator system.

K780 X-ray Generator

The K780 X-ray generator is a high-frequency, solid-state X-ray generator that provides a stable source of power for operations up to 60 kilovolts (kV) and 50 milliamps (mA).

Typical maximum power settings for the APEX II system with a fine focus tube are:

- 50 kV, 40 mA for Mo radiation
- 40 kV, 30 mA for Cu radiation

Either copper or molybdenum tubes may be used on APEX II systems. For both types of tubes, the kV setting should not exceed 50 kV and the power (kV x mA) should not exceed the power rating given on the tube cap.

Because the generator is interfaced to the controller, the power settings can be adjusted within the APEX2 software. This is usually not necessary as the software automatically increases the power to the user-defined values at the beginning of an experiment and lowers them when the instrument is inactive.
Timing Shutter and Collimator

On SMART APEX II systems, the monochromatic X-ray beam then passes through the labyrinth, the timing shutter, and the incident beam collimator before striking the crystal.

On Kappa APEX II systems, the monochromatic X-ray beam passes through a small labyrinth, the timing shutter, a secondary labyrinth and the incident beam collimator before illuminating the crystal.

- The labyrinth is a device that ensures that the collimator and shutter are tightly connected to prevent X-ray leakage.
- The timing shutter is a device which precisely controls the exposure time for each frame during data collection. Its status lamps indicate when the shutter is open (ON) and closed (OFF). For SMART APEX II systems, this assembly also houses an automatic attenuator. Kappa APEX II systems do not have an attenuator.
- The incident beam collimator is equipped with pinholes in both the front (near the crystal) and rear (near the source). These pinholes help to define the size and shape of the incident X-ray beam that strikes the crystal. (Collimators are available in a variety of sizes, depending on your application.)
- The beamstop catches the remainder of the direct beam after it has passed the crystal. The beamstop has been aligned to minimize scattered X-rays and to prevent the direct beam from hitting the detector. The entire collimator assembly is supported by a collimator support assembly that has been precisely aligned to guarantee that the X-ray beam passes through the center of the goniometer.

Video Microscope

The video microscope, an essential part of the system, allows you to visualize the crystal to optically align it in the X-ray beam. It also allows you to measure the crystal’s dimensions and index crystal faces with APEX2’s Face Indexing feature. The microscope is interfaced to the computer and is operated through the VIDEO program. The VIDEO program includes several computer-generated reticles and scales to make it easy to center and measure the crystal’s physical dimensions.
2.1.3 Radiation Safety Enclosure with Interlocks and Warning Lights

A common component of all systems in the D8 family is the radiation safety enclosure. This new design is fully leaded (i.e., leaded windows, leaded metal sides and panels) to protect you from stray radiation. The enclosure also includes warning lamps (a government requirement) that alert you when X-rays are being generated. As a special feature, the enclosure also incorporates interlocks for both hardware and software: an automatic system-interruption device that senses when the doors and panels are open and prevents data collection and use of the shutter until you close the doors.

2.1.4 D8 Controller

The D8 controller is an electronic module enclosed in the rack behind the front panel of the instrument. It contains all of the electronics and firmware for controlling the generator, opening the X-ray shutters, and monitoring other instrument functions such as safety interlocks, generator status, and detector status.

The goniometer is controlled by the D8 controller.

2.1.5 Refrigerated Recirculator for the Detector

To minimize dark current in the APEX II detector, dual Peltier devices are used to cool the CCD chip to approximately -58°F (-50°C). The refrigerated recirculator uses an ethylene glycol/water mixture to absorb the heat from the Peltier devices.

2.1.6 Computer(s)

The SMART or Kappa APEX II system uses a single computer for control of the experiment, storage of raw frame data, integration of the data, and solution and refinement of the structure.

An additional client computer can be set up to improve the performance of the system.

The computer or computers are often attached to a network of similarly configured computers with access to local and/or network printers.

NOTE: Connection to the external network must be done with care. Consult with local security experts.
2.1.7 Accessories

Various devices can be mounted on the goniometer base. These include optional low- and high-temperature attachments. Both instruments can be used with diamond-anvil cells.
3 Software Overview

This section presents an outline of the APEX2 software, including a brief description of the software layout as well as the graphical user interface (GUI).

From a software and operational viewpoint, the APEX II systems use the GUI of the APEX2 software program to control all operations from crystal screening to report generation for a typical crystallography study. This is a complete departure from the command-driven, functionally separate modules of SMART, SAINTPLUS and SHELXTL. Enhanced versions of the proven and widely-accepted programs used by these modules (e.g., SAINT, SADABS, XPREP, XS, XM, XL, etc.) underlie the APEX2 GUI and provide powerful tools.

3.1 Introduction to Client and Server Functions

The various programs within the APEX2 Suite have a client/server relationship (Figure 3.1), in which the server program (BIS) executes commands given by one of several client programs (APEX2, APEX2Server, or BCP).
Figure 3.1 – APEX2 software relationships
3.2 Server Functions

3.2.1 APEX2Server

APEX2Server is operated on the computer that controls the instrument. It provides functionality for quickly centering a crystal and determining its diffraction quality.

APEX2Server contains two main modules: Align Crystal and Simple Scans (see Figure 3.2). APEX2Server is covered in more detail in Chapter 5.

Figure 3.2 – APEX2Server’s Simple Scans window
3.2.2 Bruker Instrument Service (BIS)

BIS acts as a server to the client programs APEX2Server, APEX2, and BCP, providing a link between the hardware and software. Once a connection is established, BIS executes hardware commands sent by the client programs. BIS can also be used as a service tool, displaying diagnostic messages during operation.

Figure 3.3 – BIS main window
3.3 Client Functions

3.3.1 APEX2 Program

The APEX2 program is a GUI with multiple plug-ins, or *modules*, for different aspects of an experiment. The APEX2 program includes a sample database that stores relevant data from each step in the experiment. Details of the functions available in the GUI will be explained in more detail later in this User Manual.

3.3.2 Bruker Configuration Program (BCP)

BCP is used to configure BIS, as well as to provide instrument control and alignment tools.

From the BCP menu (see Figure 3.4), default parameters for specific hardware elements can be updated. BCP writes these values to the file BrukerInstrument.ini, which is read by BIS. When changes are saved in BCP, BIS automatically reads in the new values. See M86-Exx043 BCP and BIS Installation Notes, in addition to the online help within BCP, for more information.

![Figure 3.4 – BCP main window (Configuration screen)](image)
3.3.3 The Sample Database

The sample database is used for the storage of data generated by the APEX2 Suite. It is designed to transparently handle data from all of the APEX2 modules without intervention from the user.

The sample database is used internally by the APEX2 Suite and is not available for user customization or manipulation. It is automatically started on computer startup, and it is automatically stopped before the computer is shut down.

Structure of the Sample Database

The tables in the database are divided into four categories.

First, there are tables with users’ data, such as user names, passwords, and contact information. These tables provide information about a user's working group and information about for whom the sample is scanned. The administrator assigns each user to a working group or groups (See M86-Exx092 User Manager User Manual for more information).

The second set of tables contains data about the sample. These tables contain all of the sample data required by APEX2’s various modules. Data with a single value per sample are contained in a table called “samples.” Preliminary information about the sample, such as the name, ID, and color, are stored in the “samples” table as well. Data with multiple values per sample are contained in other tables linked to the “samples” table.

A third set of tables contains the values of standard crystallographic data, such as Laue classes, space groups, and point groups. These tables are referenced by the sample data and are not modified in any way by the user.

Finally, there are a few miscellaneous tables dealing with audit trails, version control of the database, and other assorted functions.
3.4 The APEX2 GUI

The APEX2 graphical user interface (GUI) has one main window (see Figure 3.5).

This window is divided into five sections:

- Title Bar
- Menu Bar
- Tool Icon Bar
- Task Bar
- Task Display Area

Figure 3.5 – APEX2 GUI
NOTE: Throughout the APEX2 user interface, input fields with pink backgrounds indicate invalid entries. Disabled (greyed-out) fields indicate that a feature is not available, i.e., not supported or dependent upon the instrument configuration.

3.4.1 Title Bar
The Title Bar displays the name and version of the software, user name, sample name, license type, and option currently selected in the Task Bar. The right edge of the Title Bar also contains the three buttons used by Windows for minimizing, restoring, and closing the APEX2 main window.

3.4.2 Menu Bar
The Menu Bar provides drop-down menus for a variety of file operations, image tools, and help files.

An icon for the currently active window appears on the left side of the Menu Bar. Clicking on this icon allows you to minimize, restore, resize, close, or move the currently active window.
## Sample Menu

<table>
<thead>
<tr>
<th>Sample menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login...</td>
<td>Opens a dialog window for logging into the Sample Database using your username and password.</td>
</tr>
<tr>
<td>Logout</td>
<td>Logs out of the Sample Database.</td>
</tr>
<tr>
<td>New...</td>
<td>Lets you create a new sample in the Sample Database.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens a previously saved sample.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current sample.</td>
</tr>
<tr>
<td>Archive</td>
<td>Opens a dialog for archiving samples in the Sample Database (to CD or .zip files). Previously archived samples can also be restored using this dialog.</td>
</tr>
<tr>
<td>Import</td>
<td>Allows you to import crystal information contained in a .p4p or .spin file into the Sample Database.</td>
</tr>
<tr>
<td>Export</td>
<td>Allows you to export crystal data for the current sample as a .p4p file.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the application. This menu item has the same function as the ( \text{X} ) button in the corner of the Title Bar.</td>
</tr>
</tbody>
</table>

Table 3.1 – Sample menu commands
Instrument Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection...</td>
<td>Opens a connection to a server computer running BIS. If connected already, select this menu to disconnect.</td>
</tr>
<tr>
<td>Status...</td>
<td>Opens a window showing a summary of the current status of the instrument and your connection to it.</td>
</tr>
<tr>
<td>Toggle Shutter</td>
<td>Instructs BIS to send a shutter open or close command to the instrument. If all interlocks and safety circuits are satisfied, the shutter will open and close.</td>
</tr>
<tr>
<td>Abort...</td>
<td>Stops a currently-running data set.</td>
</tr>
</tbody>
</table>

Table 3.2 – Instrument menu commands

Windows Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window selection</td>
<td>Displays a list of active windows. Any of these windows may be brought to the front by clicking its title in the Windows menu.</td>
</tr>
</tbody>
</table>

Table 3.3 – Windows menu commands

Help Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About APEX2...</td>
<td>Displays version and copyright information for APEX2.</td>
</tr>
</tbody>
</table>

Table 3.4 – Help menu commands
3.4.3 Tool Icon Bar

Some icons on the Tool Icon Bar provide shortcuts to the options available through the Menu Bar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create entry" /></td>
<td>Create a new entry in the sample database.</td>
</tr>
<tr>
<td><img src="image" alt="Open entry" /></td>
<td>Open an existing entry in the sample database.</td>
</tr>
<tr>
<td><img src="image" alt="Save current" /></td>
<td>Save the current information to the sample database.</td>
</tr>
<tr>
<td><img src="image" alt="Restore archived" /></td>
<td>Open the dialog for restoring a previously archived sample.</td>
</tr>
<tr>
<td><img src="image" alt="Archive current" /></td>
<td>Open the dialog for archiving the current sample.</td>
</tr>
<tr>
<td><img src="image" alt="Delete sample" /></td>
<td>Delete samples from the database.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>“What’s this?” Context-sensitive help.</td>
</tr>
</tbody>
</table>

Other icons on the Tool Icon Bar are visible only when a frame is displayed.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open frame" /></td>
<td>Open a frame.</td>
</tr>
<tr>
<td><img src="image" alt="Select first frame" /></td>
<td>Select the first frame in a run.</td>
</tr>
<tr>
<td><img src="image" alt="Select previous frame" /></td>
<td>Select previous frame.</td>
</tr>
<tr>
<td><img src="image" alt="Reverse display" /></td>
<td>Sequentially display frames in reverse as a movie.</td>
</tr>
<tr>
<td><img src="image" alt="Stop reverse display" /></td>
<td>If displaying frames as a movie, stop the movie.</td>
</tr>
<tr>
<td><img src="image" alt="Display frames" /></td>
<td>Sequentially display frames as a movie.</td>
</tr>
<tr>
<td><img src="image" alt="Select next frame" /></td>
<td>Select next frame.</td>
</tr>
<tr>
<td><img src="image" alt="Select last frame" /></td>
<td>Select the last frame in a run.</td>
</tr>
<tr>
<td><img src="image" alt="Adjust display rate" /></td>
<td>Adjust the rate of display when viewing frames as a movie.</td>
</tr>
<tr>
<td><img src="image" alt="Go down one run" /></td>
<td>Go down one run.</td>
</tr>
<tr>
<td><img src="image" alt="Go up one run" /></td>
<td>Go up one run.</td>
</tr>
<tr>
<td><img src="image" alt="Draw resolution circle" /></td>
<td>Draw a resolution circle.</td>
</tr>
<tr>
<td><img src="image" alt="Draw plotting line" /></td>
<td>Draw a plotting line.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom in" /></td>
<td>Change the part of the frame displayed while zoomed in.</td>
</tr>
<tr>
<td><img src="image" alt="Select region" /></td>
<td>Select a region of the frame.</td>
</tr>
</tbody>
</table>

Table 3.5 – Tool Icon Bar: Menu Bar shortcuts

Table 3.6 – Tool Icon Bar: displayed frame controls
3.4.4 Task Bar

The Task Bar provides menus for all of the functions available in the APEX2 Suite.

**NOTE:** If the Task Bar cannot be seen, there is no open sample. Click **Sample > New...** or **Sample > Open...** to open or create a new sample.

<table>
<thead>
<tr>
<th>Setup</th>
<th>Evaluate</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Describe" /></td>
<td>Reciprocal Lattice Viewer – 3D visualization of the lattice projected in reciprocal space.</td>
</tr>
<tr>
<td><img src="image" alt="Center Crystal" /></td>
<td>View Images – View and analyze diffraction images.</td>
</tr>
</tbody>
</table>

Table 3.7 – Setup

<table>
<thead>
<tr>
<th>Evaluate</th>
<th>Collect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Determine Unit Cell" /></td>
<td>Data Collection Strategy – Simulate data collection and determine strategy.</td>
</tr>
<tr>
<td><img src="image" alt="Transform Unit Cell" /></td>
<td>Experiment – Sequence editor for data collection experiments.</td>
</tr>
<tr>
<td><img src="image" alt="Oriented Scans" /></td>
<td>Oriented Scans – Measure diffraction frames with the crystal aligned along axes.</td>
</tr>
</tbody>
</table>

Table 3.8 – Evaluate

<table>
<thead>
<tr>
<th>Integrate</th>
<th>Collect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Integrate Images" /></td>
<td>Integrate Images – Integrate diffraction data.</td>
</tr>
</tbody>
</table>

Table 3.9 – Collect

<table>
<thead>
<tr>
<th>Integrate</th>
<th>Collect</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3.10 – Integrate
### Scale

| Crystal Faces – Determine Miller indices and distances of single-crystal faces. |
| Scale – Scale intensities and perform absorption correction. |

Table 3.11 – Scale

### Examine Data

| Phase ID (optional) – Display and integrate single and multiple frames. |
| Space Groups and Statistics – Determine the space group. |
| Compare Unit Cells – Compare unit cells to find twin laws. |
| Precession Images – Create precession images based on measured frames. |
| Space Group Determination – Run XPREP. |

Table 3.12 – Examine Data

### Solve Structure

| AutoStructure (optional) – Automatic solution and refinement with minimum user input. |
| Structure Solution – Solve the structure. |
| View Molecule – Visualize the molecule in 3D. |

Table 3.13 – Solve Structure

### Refine Structure

| Structure Refinement – Run XP, XL, or XSHELL. |

Table 3.14 – Refine Structure
### Report

<table>
<thead>
<tr>
<th>Report</th>
<th>Generate Report – Run XCIF to generate a report.</th>
</tr>
</thead>
</table>

Table 3.15 – Report

### Instrument

<table>
<thead>
<tr>
<th>Instrument</th>
<th>System Calibration – Make calibration measurements.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Unwarp and convert images – Convert frames between formats.</td>
</tr>
<tr>
<td></td>
<td>Play Tic Tac Toe – Play a game of Tic Tac Toe!</td>
</tr>
</tbody>
</table>

Table 3.16 – Instrument
**Stack Bar And Tree View**

Right-click in the Task Bar to choose one of two views: **Stack Bar** or **Tree View**.

In **Stack Bar** view, click one of the Task Bar sections labeled **Setup**, **Evaluate**, **Collect**, **Integrate**, **Scale**, **Examine Data**, **Solve Structure**, **Refine Structure**, **Report**, or **Instrument** to display only the icons belonging to that section. All other Task Bar icons will be hidden.

In **Tree View**, sections may be expanded to display their Task Bar icons by clicking the plus or minus sign next to the section name.
3.4.5 Task Display Area

The Task Display Area is the main area for tasks, user input, and selected output. This area displays images, the reflections used in indexing, and observed and predicted diffraction patterns. It also displays the runs for data collection and solution and refinement.

**NOTE:** In APEX2 Version 2, XShell refinement and XCIF report generation do not use the Task Display Area; they open in new windows. All other modules open in the Task Display Area of APEX2’s Main Window.

![Figure 3.8 – Task Display area showing the Data Collection Strategy module](image-url)
4 Program Startup and Shutdown

As discussed in Chapter 3, the APEX2 Suite is composed of several programs. All of the programs are started in a similar fashion. For ease of use there is usually a desktop icon for the folder containing these programs, and desktop shortcuts linked directly to these programs. However, the Start > Programs > Bruker AXS path is always available. This more explicit method will be used in this discussion.
4.1 Access to BCP and APEX2

Bruker software allows different user accounts to have different levels of access to the instrument:

- Service
- Security
- Administrator
- User
- Non-user

**NOTE**: You need Bruker Instrument Administrator rights to run BCP and Bruker Instrument User rights to run APEX2. Typically, your system administrator will already have your user account configured or you will be using the default accounts as provided by Bruker AXS.

4.2 Online and Offline Operation

APEX2 can operate in either *online* or *offline* mode.

In online mode, APEX2 is connected to BIS in order to communicate with the instrument for performing experiments. To use APEX2 in online mode, you must start BIS, APEX2, and optionally, VIDEO.

In offline mode, APEX2 is not connected to the instrument, but is still able to analyze and interpret existing data. To use APEX2 in offline mode, you only need to start APEX2.
4.3 Startup

4.3.1 Starting Bruker Instrument Service (BIS)

BIS is the link between the hardware and the APEX2 software. The BIS software executes hardware commands issued by APEX2.

1. To start BIS, select Start > Programs > Bruker AXS > Administration > BIS (Figure 4.1).

2. Once the BIS window appears, you may be asked to confirm the detector distance.

4.3.2 Starting APEX2

APEX2 is used to set up crystallographic experiments and to process crystallographic data.

1. To start APEX2, select Start > Programs > Bruker AXS > APEX2.
2. The Login window appears automatically when you start APEX2. At the Login window, enter your user name and password. As shipped by Bruker AXS, the default account is “guest” with password “guest.” Click OK.

3. For online operation within APEX2, select Instrument > Connection.... In the Instrument Connection window, enter the instrument host name. The window shows the default host. Click Connect.

NOTE: By editing the “bn-config.py” configuration file, APEX2 may be configured to start without displaying the Instrument Connection window. In this mode, APEX2 automatically connects to the user-specified IP address or DNS name of a computer running BIS. More information about the bn-config.py file may be found in M86-Exx087 APEX2 and PROTEUM2 Installation Notes and in Appendix D.

You are now ready to begin using APEX2.
4.4 License Considerations

You need a software license to activate your purchased software packages, options, and/or features.

APEX2 requires a valid license file to operate. This file, “bn-license.dat”, must be present in the root directory of drive C:\ for the software to start properly.

If the license file is not present or has expired, an error window will appear when you try to start APEX2. This window prompts you to run the License Manager application to obtain a valid license for APEX2.

For more information on licenses and License Manager, refer to M88-Exx099 License Manager User Manual.

![Error window](image)

Figure 4.5 – “No valid license” window
4.5 Shutdown

4.5.1 Shutting Down APEX2

1. First, log out of the sample database by going to Sample > Logout within APEX2. In the “Closing Sample” window, select whether to save or discard the changes to the sample database.

   ![Closing Sample Window]

   Figure 4.6 – “Closing Sample” window

   **NOTE:** The “Closing Sample” window appears even if no apparent changes were made to the sample database because the date and time of the last access are held in the sample database and differ from the current date and time.

2. Within APEX2, select Sample > Exit. APEX2 closes.

4.5.2 Shutting Down BIS

1. To stop BIS, click the Exit button in the upper right-hand corner of the BIS window. You may be asked to place the generator into Standby mode.

2. At the confirmation dialog, click OK. BIS closes.
We are now ready to begin the process of data collection with the instrument. It is assumed that your system administrator has set up the system properly and that all system default parameters have been set appropriately.

The data collection process is divided into five steps, which will be covered in Chapter 5 and Chapter 6.

The steps in Chapter 5 are performed using the APEX2Server software on the computer controlling the instrument (i.e., the Server in a dual-computer setup).

The steps in Chapter 6 are performed using the APEX2 program (on the Client computer in a dual-computer setup).

See Chapter 5 for:

- Centering the crystal on the diffractometer (using APEX2Server's Center Crystal module)
- Crystal quality check (using APEX2Server's Simple Scans module)

See Chapter 6 for:

- Cell determination (using APEX2's Determine Unit Cell module)
- Data collection setup (using APEX2's Data Collection Strategy module)
- Data collection (using APEX2's Experiment module)

5.1 Start APEX2Server

1. If APEX2Server is not running on the computer controlling the instrument, start it by going to Start > Programs > Bruker AXS > APEX2Server.
2. Ensure that APEX2Server is connected to the instrument by checking the Instrument > Status... menu.

5.2 Mount the Goniometer Head on the Instrument

1. Open the enclosure doors by pushing either of the rectangular green Open Door buttons on the enclosure's side posts. This releases the door locks for approximately five seconds. While the door locks are released, pull outward on one or both of the handles to physically open the doors.

![Figure 5.1 – D8 Enclosure Open Door button](image1)

2. Under Setup in APEX2Server's Task Bar, click Center Crystal. The centering buttons (Figure 5.2) appear and the VIDEO program window opens.

![Figure 5.2 – Centering buttons](image2)
**NOTE**: If the VIDEO window does not stay on top of the APEX2Server window, select **Grab > On top** from the VIDEO program Menu Bar.

The bottom five buttons in Figure 5.2, **Mount, Left, Top, Right, and Center**, drive the goniometer to various pre-defined positions that are designed to simplify crystal centering. The two large square buttons rotate phi by either 90 or 180 degrees.

3. **Click Mount** to drive the goniometer to a convenient position for mounting the goniometer head.

4. Carefully remove the goniometer head containing the crystal from its case.

⚠️ **CAUTION**

Use extreme care when handling the goniometer head to prevent damage to the crystal on the end of the small glass fiber.

5. Place the goniometer head onto its base on the phi drive. Line up the slot on the bottom of the goniometer head with the pin on the mounting base (see Figure 5.3).

6. Screw the goniometer head collar to the base so that the head does not move. Do not overtighten it (finger-tighten only).
Figure 5.4 – Huber goniometer head in detail
Figure 5.5 – Nonius goniometer head in detail
5.3 Center the Crystal

To obtain accurate unit cell dimensions and collect good quality data, position the crystal in the center of the X-ray beam and maintain this position for the entire experiment.

Your video microscope should be aligned so that the reticle of the video microscope coincides with the center of the goniometer and the center of the X-ray beam (for instructions on aligning the microscope to the center of the instrument, see M86-Exx024 Microscope Focus and Sample Alignment).

If the microscope is not centered, you can still center the crystal. A successfully centered crystal stays in the same place in the microscope's field of view in all orientations.

To center the crystal on a Kappa APEX II system, see Section 5.3.1.

To center the crystal on a SMART APEX II system, see Section 5.3.2.

**NOTE:** Use the thin end of the goniometer wrench to unlock the X, Y and Z locks at the beginning of the centering process and to lock them at the end. Locking needs only a very slight touch. The other end of the wrench is used to move the adjustment sleds. Do not overtighten the locks.

**NOTE:** Centering is often easier if the crystal is rotated to give a good view before the actual centering process is started (e.g., down an edge for a plate). To do this, click Center to drive to the initial centering position, loosen the crystal mounting screw, rotate the crystal to a suitable orientation, and then tighten the screw again.
5.3.1 For Kappa APEX II Systems

1. Click the **Center** button. The goniometer head drives so that its Y and Z translation axes are positioned perpendicular to the microscope. The Y- and Z-axis adjustment screws should be facing the front of the diffractometer. If they are not, click **Spin Phi 180**.

   ![Figure 5.6 – Center position, Y- and Z-axis adjustment screws](image)

2. Center the crystal in the video microscope reticle by making adjustments to the Y- and Z-axis adjustment screws.

   ![Figure 5.7 – Crystal initially mounted](image)

   ![Figure 5.8 – Centered crystal after Y- and Z-axis adjustments](image)
3. **Click Spin Phi 180** and check that, after rotating 180°, the crystal appears in the same position in the microscope reticle. If the crystal does not appear in the same position:

3.1 Use the adjustment screw facing you to remove **half** of the difference shown in the reticle (Figures 5.9 and 5.10).

3.2 **Click Spin Phi 180.**

3.3 Repeat steps 3.1 and 3.2 until you are satisfied that the crystal remains in the same position in the microscope reticle when rotated by 180°.

**NOTE:** If the crystal consistently fails to appear in the same position when rotated by 180°, the position of the microscope reticle may need adjustment. For more information, refer to M86-Exx024 Microscope Focus and Sample Alignment.
4. Click **Spin Phi 90**. Phi rotates so that the X-axis adjustment is facing forward. Any error in the crystal’s position along the X-axis will now appear in the microscope.

![Figure 5.11 – Center position, X-axis adjustment screw](image)

5. Center the crystal in the video microscope reticle by making adjustments to the X-axis adjustment screw.

![Figure 5.12 – X-axis error after spinning phi 90°](image)

![Figure 5.13 – Centered crystal after X-axis adjustments](image)
6. Alternately click Spin Phi 180 and Spin Phi 90 to verify that the crystal stays in the same place in the microscope reticle through all motions of phi. If the crystal fails to stay in the same position as phi is rotated, make adjustments to the axes by repeatedly removing half the error as in step 3.

7. Click the Left button. The goniometer drives to place the fiber horizontal and to the left. Note the height of the crystal in the video microscope reticle.

Figure 5.14 – Left position

Figure 5.15 – Crystal in left position
8. Click the **Right** button. The goniometer drives to place the fiber horizontal and to the right.

![Figure 5.16 – Right position](image1)

![Figure 5.17 – Crystal in right position](image2)

9. Check that the crystal height is the same as the height you noted in step 7.
   - **9.1** If the height is the same, proceed to step 10.
   - **9.2** If the height is not in the same place, adjust to remove half of the difference, click **Spin Phi 180**, and repeat steps 7 to 9.
10. Click the **Top** button. The goniometer drives so that the phi axis is pointing directly into the microscope.

![Figure 5.18 – Top position](image1)

![Figure 5.19 – Crystal in top position](image2)

11. Click **Spin Phi 180** a few times to verify that the crystal stays in the same position as Phi rotates. If the crystal does not remain centered, go back to step 1.

12. Click **Center** to drive the goniometer back to the center position. The crystal is now centered on the instrument.
5.3.2 For SMART APEX II Systems

**NOTE**: If the image of the crystal is difficult to see, illuminate the crystal with a high-intensity lamp and/or temporarily place a light-colored piece of paper on the front of the detector.

1. Click the **Right** button. The crystal and goniometer head drive to a position perpendicular to the microscope. To center the crystal, make adjustments to the height with the Z-axis adjustment.

![Figure 5.20 – Right position, Z-axis adjustment screw](image1)

![Figure 5.21 – Initial mounted crystal](image2)
2. Click the **Center** button. Move the crystal so that it is centered in the microscope reticle by adjusting the X- or Y-axis translation adjustment screw that is perpendicular to the microscope axis and facing you (see Figure 5.4 and Figure 5.5).

![Figure 5.22 – Center position, Y and Z adjustments](image)

![Figure 5.23 – Initial center position before X- or Y-axis adjustment](image)

![Figure 5.24 – Crystal after X- or Y-adjustments](image)
3. Click **Spin Phi 90**. Remove half of the difference with the adjustment screw that is facing you.

![Figure 5.25 – Example: error in X-axis](image)

4. Click **Spin Phi 180**. Remove half of the difference with the adjustment screw that is facing you.

5. Click **Spin Phi 180** again.

6. If the crystal is centered, click **Spin Phi 90**.

7. If the crystal is not centered, adjust to remove half of the difference and click **Spin Phi 180**. Repeat until the crystal is centered. Click **Spin Phi 90**.

8. If centered, adjust the height. If not centered, repeat steps 3 through 7 until it is centered.

![Figure 5.26 – Example: error removed by half](image)
9. Click the **Left** button. Adjust to remove half of the difference. Adjust the height.
10. Click the **Right** button. Adjust the height. Adjust to remove half of the difference.

11. If a height adjustment was made in step 6 or 7, repeat those steps to check the height. If the height is adjusted, repeat steps 2 to 5 to check the centering. If no height adjustment was made, the crystal is centered.

The crystal is now centered on the instrument.
5.4 Simple Scans

APEX2Server's Simple Scans software module provides tools for rapid screening of the crystal to check crystal quality. It allows you to quickly set up scans to measure a 360° phi rotation as well as thin (0.5°) and thick (2.0°) still images.

1. Under Setup in APEX2Server's Task Bar, click Simple Scans. The menu shown in Figure 5.32 opens.

![Figure 5.32 – Simple Scans menu](image-url)
The sliders and data boxes at the top can be used to position the detector.

The buttons in the middle provide easy access to common movements.

There are four possible user-defined buttons.

The **Drive** button initiates the requested movement. If it is gray, an impossible movement has been requested.

The buttons and boxes at the bottom set up scans. In Figure 5.32, the **Drive + Scan** button is grey and therefore inactive because no scan has been requested.

1. Click **Zero** and then **Drive**.
2. Set the distance.
   2.1 On Kappa APEX II systems, check that the moveable beamstop is pushed in and set the desired position (typically 45 mm) for Distance in the data window.
   2.2 On SMART APEX II systems with movable DX, set the desired position (typically 50 mm) for Distance in the data window.
   2.3 On SMART APEX II systems with fixed DX, check that the distance displayed is the same as the actual distance in mm on the detector arm.
3. Click **360° Phi** and set the desired exposure time. The default of 15 seconds is usually sufficient.
4. Click **Drive + Scan**. Since these are evaluation scans, there is no need to request correlated images or new darks. The shutter opens and the phi scan begins. The resulting Phi 360° image is shown in Figure 5.33. The crystal diffracts nicely with lots of sharp spots. Figure 5.37 shows a Phi 360° scan with a bad crystal.

![Figure 5.33 – A 360° Phi scan on a good quality crystal](image)

5. Click **Wide (2.0)**. The phi scan range changes to 2°. An exposure time of 5 to 15 seconds is usually sufficient for a wide scan.
6. Click **Drive + Scan**. The resulting 2° scan is shown in Figure 5.34. The spots are sharp and clean. There are no peaks that are very close together. Figure 5.38 shows a 2° scan with a bad crystal.

7. Click **Phi + 90** in the middle row of boxes.

8. Click **Drive + Scan**. The resulting 2° scan is shown in Figure 5.35. This image is measured 90° from the previous one, giving a view of the diffraction pattern from a different (perpendicular) direction. Figure 5.39 gives a similar view for the poor crystal.

---

Figure 5.34 – A 2° phi scan on a good quality crystal. The spots’ shapes are well-defined and the spots are well-separated.

Figure 5.35 – A 2° phi scan at phi = +90° on a good quality crystal. The spots’ shapes are well-defined and the spots are well-separated.
9. Set 2-theta to -30°. This will allow evaluation of the diffraction at higher angles.

10. Click **Drive + Scan**. The resulting image is shown in Figure 5.36.

Figure 5.36 – A 2° phi scan on a good quality crystal at 2-theta = -30°. The cursor is pointing to an area between the two reflections shown in the 3D View window. The cursor position tab at the bottom left shows that the resolution is 0.93Å and 2-theta is 45°.
5.5 Examples of Poor Quality Crystals

Figure 5.37 – A 360° phi scan on what is likely a poor quality crystal. The spot shape is poor and the spots tend to run together. The obvious bands on the image suggest that the crystal is nearly aligned along an axis; however, spots will always apparently run together in a nearly aligned crystal mounting. Figure 5.38 is much more convincing proof of a poor quality crystal.

Figure 5.38 – A 2° phi scan on a poor quality crystal. The spot shape is poor and some spots seem split.
Figure 5.39 – A 2° phi scan on a poor quality crystal at plus 90 in phi. The spot shape is poor and the spots are very close together.

Figure 5.40 – A 360° phi scan on a small crystal. The diffraction power of the crystal is small, but with longer exposure times this is clearly a reasonable candidate for data collection.
6 Data Collection

The data collection process is carried out on the client computer using APEX2. Once data collection is started, exit APEX2 (optional). Data collection will continue regardless.
6.1 Create a New Sample

1. After starting APEX2 and logging in, select Sample > New....

2. In the window that appears, enter the sample name. APEX2 will automatically create a directory for data storage.

3. Click OK. The Task Bar appears with the Setup section open.

4. Click Describe.

5. Enter the requested information into the Describe window.

Figure 6.1 – New Sample window
6. Close the Describe module by clicking the button on the right-hand side of the Menu Bar. APEX2 will automatically save the data to the sample database.
6.2 Determine the Unit Cell

Unit cell determination is performed in several steps:

- Data collection
- Harvesting of reflections from collected frames
- Indexing of harvested reflections
- Bravais lattice type determination
- Refinement

In APEX2 Version 2, these steps are integrated in the Determine Unit Cell module (located in APEX2's "Evaluate" category), which also contains a one-click solution for fully-automated unit cell determination.

The upper right-hand corner of the Determine Unit Cell module contains two sections:

- **Automatic Mode** - for fully-automated unit cell determination (Section 6.2.1).
- **Manual Mode** - for unit cell determination with user-defined parameters (Section 6.2.2).

**NOTE:** The Determine Unit Cell module automatically determines crystal mosaicity and provides a table of exposure time versus diffraction limit (Figure 6.3, lower right-hand corner).

This table is strictly informational and its contents are not used when determining exposure times for a data collection strategy. However, you can use the information in the table to manually set exposure times for your maximum desired resolution.

For more information on the Data Collection Strategy module, refer to Section 6.3.
Figure 6.3 – Determine Unit Cell module
6.2.1 Automatic Mode

1. In the Task Bar, click Evaluate and then Determine Unit Cell. The Determine Unit Cell module appears (Figure 6.3).

2. From the Start At: pull-down menu, select the step at which you want APEX2 to begin automatic unit cell determination (useful if you want to find a unit cell from frames that have already been collected).

3. From the Stop After: pull-down menu, select the step at which you want APEX2 to stop automatic unit cell determination.

4. Click Run. Automatic data collection begins and collected frames appear in the Information Display Area. The area containing the Automatic and Manual mode options changes to a list showing APEX2’s progress through the steps of unit cell determination.

5. When automatic unit cell determination is complete, the progress list will show a check mark and comments for each completed step (Figure 6.5).

6. Click the Close button to close the progress list and return to the main Determine Unit Cell window. The right-hand side of the window displays the unit cell parameters obtained by APEX2, along with options to edit or delete the unit cell and reflection list if you wish to perform additional operations in Manual Mode (more information on Manual Mode operations is given in Section 6.2.2).
6.2.2 Manual Mode

The Determine Unit Cell Module's Manual Mode functions allow you a great degree of control over unit cell determination. Manual Mode consists of five sections, each with its own menu, corresponding to the five stages of unit cell determination:

- Collect Data
- Harvest Spots
- Index
- Bravais
- Refine
### Collect Data

**Menu Item** | **Function**
---|---
Image Location: | Location where collected frames will be saved.
Image Base Name: | Text string that is appended to each frame's filename and is used to identify frames by their filenames.
First Run: | Choose which run number will be the first run; useful for adding runs without overwriting previous ones.
Distance [mm]: | Detector distance.
Exposure Time: | Duration, in seconds, of each frame.
Image width [deg]: | Distance, in degrees, that the scan axis travels over the course of a single exposure.
Detector Format: | Resolution of the frames collected by the detector.
Correlate Frames: | Two frames are taken (each with half the duration of the overall Exposure Time), to correct for spurious events appearing on individual frames.
[ ] [left arrow] | Go to the previous step in the unit cell determination process.
[ ] [right arrow] | Go to the next step in the unit cell determination process.
Finish | Finish the sequence of steps in the unit cell determination process, beginning with the current step. Perform any tasks that are necessary.
Collect... | Proceed with data collection according to the options set in the preceding menu items.
Cancel | Leave Manual Mode and return to the initial Unit Cell Determination page, performing no operations and ignoring any changes made to menu items.

Table 6.1 – Collect Data menu items

![Figure 6.6 – Collect Data menu](image-url)
Harvest Spots

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Image:</td>
<td>Select the first image in the group of images to be examined for spots.</td>
</tr>
<tr>
<td>Number of Runs:</td>
<td>Number of runs to be examined.</td>
</tr>
<tr>
<td>Images Per Run:</td>
<td>Number of images to be examined in each run.</td>
</tr>
<tr>
<td>Go to Image:</td>
<td>Select a frame filename from this drop-down menu to display the frame in the Image Information Area.</td>
</tr>
<tr>
<td>Min. I/sigma(I):</td>
<td>Adjust the criterion for harvesting a spot based on its pixels’ intensity versus their standard deviation. Slide the slider between “More Spots” and “Fewer Spots” to vary the minimum I/sigma(I).</td>
</tr>
<tr>
<td>Smooth images:</td>
<td>A Gaussian filter is applied to the frames prior to harvesting, which reduces the noise and eliminates falsely harvested pixels. For very weak data, however, the Smooth images function can interfere with successful harvesting.</td>
</tr>
</tbody>
</table>

Table 6.2 – Harvest Spots menu items
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluded shells:</td>
<td>Add, edit, or delete resolution shells to be excluded from the harvesting process, for example in the case of rings caused by ice or amorphous diffractors (the three inner resolution shells for water ice appear as defaults). Excluded shells are defined by their starting and ending resolution (which may be found by placing the mouse cursor on a displayed frame and referring to the Resolution [Å] field in the Cursor Position Tab).</td>
</tr>
<tr>
<td>Store (Reflection Group Combo Box):</td>
<td>The Reflection Group Combo Box shows a list of reflection groups to choose from. For each group, the group name and number of reflections in the group are displayed. If, instead of the number of reflections, an entry is labeled empty, this indicates an unassigned entry. Choosing the empty entry creates a new group instead of appending to the current one. A color is associated with each reflection group. The color is displayed in the box to the left of the group name. The color helps in recognizing a group while navigating through the software. Right-click to edit or clear groups.</td>
</tr>
<tr>
<td>Save only reflections that span images</td>
<td>With this checkbox enabled, a spot is only harvested if it is found on multiple contiguous frames.</td>
</tr>
<tr>
<td>Go to the previous step in the unit cell determination process.</td>
<td>Go to the previous step in the unit cell determination process.</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish the sequence of steps in the unit cell determination process, beginning with the current step. Perform any tasks that are necessary.</td>
</tr>
<tr>
<td>Harvest</td>
<td>Proceed with harvesting according to the options set in the preceding menu items.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Leave Manual Mode and return to the initial Unit Cell Determination page, performing no operations and ignoring any changes made to menu items.</td>
</tr>
</tbody>
</table>

Table 6.2 – Harvest Spots menu items
Index

Table 6.3 – Index menu items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reflections:</td>
<td>Opens the Reflection Group Combo Box to allow you to select a certain group of reflections for indexing.</td>
</tr>
<tr>
<td>Go to Image:</td>
<td>Select a frame filename from this drop-down menu to display the frame in the Image Display Area.</td>
</tr>
<tr>
<td>Min I/sigma(I):</td>
<td>Adjust the criterion for indexing a reflection based on its integrated intensity versus its standard deviation. Slide the slider between “More Spots” and “Fewer Spots” to vary the minimum I/sigma(I) needed for a reflection to qualify for indexing.</td>
</tr>
<tr>
<td>Resolution(Å):</td>
<td>Set the resolution range from which spots will be used to index the unit cell.</td>
</tr>
<tr>
<td>Reflections must be isolated</td>
<td>If this checkbox is active, overlapping spots will not be used for indexing.</td>
</tr>
<tr>
<td>Reflections must span images</td>
<td>If this checkbox is active, only spots which registered on at least two adjacent images will be used for indexing.</td>
</tr>
<tr>
<td>Reflections must be whole</td>
<td>If this checkbox is active, spots that have only partially registered on the first and last images of the range from which they are harvested will not be used for indexing.</td>
</tr>
</tbody>
</table>

Figure 6.8 – Index menu
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store (Unit Cell Combo Box):</td>
<td>The Unit Cell Combo Box shows a list of unit cells to choose from. For each unit cell, the unit cell parameters are displayed, as is the unit cell volume and, optionally, the Bravais lattice type. If, instead of the unit cell parameters, an entry is labeled empty, this indicates an unassigned entry. Choosing the empty entry creates a new unit cell instead of replacing the current one. A color is associated with each unit cell. The color is displayed in the box to the left of the unit cell. The color helps in recognizing a unit cell while navigating through the software. It is also used in the image display to color the overlay and indicate the unit cell that was used to calculate the overlay. Right-click to edit or clear unit cells.</td>
</tr>
<tr>
<td>Corrections:</td>
<td>Select corrections to detector parameters. Corrections are available from the stored parameters (i.e., BIS' configuration file), from the last harvest, or from manual input.</td>
</tr>
<tr>
<td>Methods:</td>
<td>Select methods employed in indexing: difference vectors, fast fourier transform, or least squares.</td>
</tr>
<tr>
<td>[left arrow]</td>
<td>Go to the previous step in the unit cell determination process.</td>
</tr>
<tr>
<td>[right arrow]</td>
<td>Go to the next step in the unit cell determination process.</td>
</tr>
</tbody>
</table>

Table 6.3 – Index menu items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish</td>
<td>Finish the sequence of steps in the unit cell determination process, beginning with the current step. Perform any tasks that are necessary.</td>
</tr>
<tr>
<td>Index</td>
<td>Proceed with indexing according to the options set in the preceding menu items.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Leave Manual Mode and return to the initial Unit Cell Determination page, performing no operations and ignoring any changes made to menu items.</td>
</tr>
</tbody>
</table>

Table 6.3 – Index menu items
Bravais

Figure 6.9 – Bravais menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initial Unit Cell:</strong></td>
<td>Use the Unit Cell Combo Box to select a unit cell to which to assign a Bravais lattice type.</td>
</tr>
<tr>
<td><strong>Bravais Lattice:</strong></td>
<td>This list shows the 14 Bravais lattice types for the selected unit cell parameters. For each entry, the list contains (from left to right) the Bravais lattice type, the figure of merit (ranging from 0.0 to 1.0, with 1.0 being perfect agreement), and the six unconstrained unit cell parameters for that Bravais lattice type. Bravais lattices that are in agreement with the unit cell are displayed in green, which those that do not are displayed in red. The most likely Bravais lattice type is chosen automatically. If necessary, you may override the program’s decision by clicking on a different entry.</td>
</tr>
<tr>
<td>[left arrow]</td>
<td>Go to the previous step in the unit cell determination process.</td>
</tr>
<tr>
<td>[right arrow]</td>
<td>Go to the next step in the unit cell determination process.</td>
</tr>
<tr>
<td><strong>Finish</strong></td>
<td>Finish the sequence of steps in the unit cell determination process, beginning with the current step. Perform any tasks that are necessary.</td>
</tr>
<tr>
<td><strong>Accept</strong></td>
<td>Accept the choice of Bravais lattice type given in the menu items above.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Leave Manual Mode and return to the initial Unit Cell Determination page, performing no operations and ignoring any changes made to menu items.</td>
</tr>
</tbody>
</table>

Table 6.4 – Bravais menu items
Refine

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Cell:</td>
<td>Use the Unit Cell Combo Box to select a unit cell to refine.</td>
</tr>
<tr>
<td>Parameters:</td>
<td>Within the Parameters window, several areas are available for refinement:</td>
</tr>
<tr>
<td></td>
<td>Unit Cell, Domain Translation, Domain Orientation, Detector Translation,</td>
</tr>
<tr>
<td></td>
<td>Beam Center, Detector Orientation, and Goniometer Zeros. By activating</td>
</tr>
<tr>
<td></td>
<td>or deactivating the checkbox on the left, the parameters in this group</td>
</tr>
<tr>
<td></td>
<td>are selected for refinement or are constrained to their current values</td>
</tr>
<tr>
<td></td>
<td>during the refinement.</td>
</tr>
<tr>
<td>Reflections:</td>
<td>Use the Reflection Group Combo Box to the select a group of reflections</td>
</tr>
<tr>
<td>Go to Image:</td>
<td>Select a frame filename from this drop-down menu to display the frame in</td>
</tr>
<tr>
<td></td>
<td>the Image Display Area.</td>
</tr>
<tr>
<td>Tolerance:</td>
<td>Upon startup, the Refine dialog determines a useful value for the</td>
</tr>
<tr>
<td></td>
<td>tolerance. This may take a few seconds depending on the number of</td>
</tr>
<tr>
<td></td>
<td>reflections.</td>
</tr>
<tr>
<td>Show selected</td>
<td>In the Image Display Area, reflections selected for refinement are</td>
</tr>
<tr>
<td>reflections</td>
<td>marked with circles.</td>
</tr>
<tr>
<td>Show predicted</td>
<td>In the Image Display Area, predicted reflections are marked with circles.</td>
</tr>
<tr>
<td>reflections</td>
<td></td>
</tr>
</tbody>
</table>

Table 6.5 – Refine menu items
### RMS XY [mm], angle [°]:

The root mean square of the deviation between observed and predicted spot positions in the XY image plane and along the trajectory of the spot while it passed through the Ewald sphere.

### Tools:

- **Refine** – Refine the unit cell using the selected parameters.
- **Transformations...** – Opens a dialog for transforming the unit cell.

### Menu Item | Function
---|---
[Left arrow] | Go to the previous step in the unit cell determination process.
[Right arrow] | Go to the next step in the unit cell determination process.
**Finish** | Finish the sequence of steps in the unit cell determination process, beginning with the current step. Perform any tasks that are necessary.
**Accept** | Accept the options set in the preceding menu items, and proceed with a single cycle of least-squares refinement. The Refine dialog has a built-in safety which checks whether enough reflections are available for the refinement. If the number of reflections is critically low, a warning is displayed with the option to override.
**Cancel** | Leave Manual Mode and return to the initial Unit Cell Determination page, performing no operations and ignoring any changes made to menu items.

Table 6.5 – Refine menu items
6.3 **Determine the Data Collection Strategy**

APEX2 includes a powerful algorithm for determining an efficient strategy that fully utilizes the flexibility of your instrument.

6.3.1 **Operation and Initial Settings**

1. Under **Collect** in APEX2’s Task Bar, click **Data Collection Strategy**. The Data Collection Strategy module opens in the Main Window (Figure 6.11).

The Data Collection Strategy module uses information from the Determine Unit Cell module (Section 6.2) to set defaults. However, you can modify the suggested values.

2. Check the inputs for defining the data collection.
   
   2.1 Set the data collection distance. For SMART APEX II systems, this should be set to the actual detector distance. For Kappa APEX II systems, the distance is variable and will default to the shortest reasonable distance. For the APEX II detector, the distance in millimeters should generally be about the same as the longest cell dimension in angstroms. Typically, distances ranging from 35 mm to 45 mm are reasonable.

   2.2 Set the exposure time and press [Enter]. For normal crystals and an APEX II detector, five seconds is a reasonable time.

   2.3 Click **Same** to set all of the times to be the same.

   **NOTE**: If the “Same” feature is not chosen, the times for shells can be set to collect high-angle data with longer exposures than inner shell data.

   2.4 Set the desired resolution (0.75Å is a reasonable value).

   2.5 Check the other values (Laue class, Lattice, etc.).

   2.6 Each time a value is changed, the Data Collection Strategy module recalculates the statistics for the runs. The results are displayed in the column labeled **Current**.

   **NOTE**: The rescanning of runs can be interrupted by pressing [Esc]. No statistics will be displayed.
Figure 6.11 – Data Collection Strategy module
6.3.2 Refining the Strategy

At this point, if all of the runs available were collected it would take 91.60 hours and the data would have a redundancy of 184.36. Of course, this is not desirable.

1. Below the “Target” and “Priority” columns is a pull-down menu with several different strategies. Choose the one that best meets the needs of the experiment (for the YLID example, Best in 2 hours was selected). The “Target” column changes to reflect your choice.

2. Click in the **Execute**: field. A list of options appears. Click **Refine Strategy**. The strategy begins to refine, approaching the target Completeness, Redundancy, and Time set in step 1.

3. When you are satisfied with the Completeness, Redundancy, and Time displayed in the “Current” column (whether the module is finished refining or not), click **Stop**. It is neither necessary nor advisable to wait until the refinement reaches 100%.

**NOTE**: When refining the strategy, the objective is to get good completion (98% or better) with high redundancy in a reasonable amount of time. When the Data Collection Strategy module is first started, it will tell you the Completeness, Redundancy, and Time for all of the available runs.

It is almost never necessary to let the Data Collection Strategy module run to completion. Typically, it should be stopped when completion is greater than 99% and the time is close to what is desired.
In the YLID example shown in Figure 6.14, the Completeness is 99.76\% and the Time is approximately 2.33 hours.

**NOTE:** Time estimates are approximate. They depend on the number of rescans, general instrument overhead, backlash compensation, etc. If estimated times are consistently longer or shorter, modify the COSMO hardware profile.

4. Click in the **Execute:** field. A list of options appears. Click **Sort Runs for Completeness**.

![Figure 6.13 – Completeness and Redundancy chart](image)

![Figure 6.14 – Strategy Status and Priority control](image)

![Figure 6.15 – Click “Sort Runs for Completeness”](image)
NOTE: If for some reason it is necessary to start over, change the distance slightly (by 0.02 for example) and press [Enter]. The Data Collection Strategy module will reload all of the possible runs.

Figure 6.16 – Completeness and Redundancy charts after sorting for completeness
6.3.3 Looking at the Current Strategy

1. To look at the actual runs chosen, select **View > Detailed Strategy.**

This opens a window that shows the runs to be collected (see Figure 6.17).

![Figure 6.17 – Current Strategy window](image)

Each line in this list represents one run. It is specified by:

- Origin
- Crystal-to-detector distance
- Angular positions of the goniometer axes
- Name of the scan axis
- Image width
- Number of Images
- Total Sweep
- Exposure time + overhead
Each run is displayed in a color that indicates its behavior during the strategy refinement:

**Black** runs are permanent and always active during the refinement process. They are not altered during the refinement. This option is intended for runs that have already been collected and therefore definitively contribute to the data set.

**Red** runs are considered as-is and, unlike the permanent runs, can be disabled by the refinement algorithm. However, the configuration of such a run remains unchanged (i.e., the scan range will not change).

**Blue** runs can change their scan range during the course of the refinement. They are therefore called partial runs. This is the default option for all runs from the basis set, because it provides the refinement algorithm with the highest flexibility in finding a strategy that fulfills the criteria for the data set completeness, its redundancy, and the total data collection time.

**Gray** runs are disabled and are not taken into account at any time during the strategy refinement.

To change the behavior of a run:

1. Place the Data Collection Strategy algorithm in idle mode, i.e., make sure that it is not calculating the reflection list, refining a strategy, or sorting the run list.
2. Select the run or runs you wish to change by clicking inside the Current Strategy window or by dragging the mouse while holding down the left mouse button.
3. Right-click inside the Current Strategy window to open the contextual menu.
4. Select the desired behavior (permanent, as-is, partial, or disabled). The Current Strategy window and the contents of the Main Window will then be updated.

You are now ready to perform the experiment using the optimum strategy.
6.4 Data Collection/Run Experiment

1. Under Collect in APEX2's Task Bar, select Experiment. The Experiment module opens.

2. Click Append Strategy. The runs determined in Section 6.3 appear in the list of operations to be performed.

3. APEX2 changes the filename to the name of the current sample (in this example, "ylid_example").

**NOTE:** You can load and save your own experiments (in *.exp format) by using the Load Table... and Save Table... buttons at the bottom of the Setup Experiment tab.

![Figure 6.18 – Deleting the matrix runs](image)

![Figure 6.19 – Experiment view with strategy appended](image)
NOTE: At the top of the Setup Experiment tab are controls for data collection. Usually, the default values are correct. For data collection times of less than five seconds, correlation can usually be turned off. If new dark frames are required, BIS will automatically collect them. Checking “Generate New Darks” forces the collection of darks before every run. In Figure 6.19, the time and width are explicitly set for each run, so changing the default width and time will have no effect. If the explicit time or width for a run is deleted so that the box is empty, the word “default” appears and the default values at the top right will be used.

4. If you choose to enter your own runs, click Validate to test the strategy for illegal movements by the goniometer. If all motions are valid, the “All operations are valid” window will appear (Figure 6.20).

NOTE: If resuming after a data collection interruption, APEX2 will automatically skip images that were previously collected with matching angles and generator settings. Otherwise, APEX2 will ask if you want to overwrite the images.

5. To begin the experiment, click Execute. APEX2 shifts to the Monitor Experiment tab and diffraction images begin to appear. This may take a minute or two if new darks are being collected, or if the generator is being ramped up from a low-power state.

NOTE: After data collection is started, the Experiment window can be closed and APEX2 can be stopped. The Server computer must be left on; in a single-computer setup, BIS must be left running. If communications are lost between the Client and the Server, frames will be stored on the Server. Typically, they will be in the directory C:\frames\. They should be copied into the correct project directory before starting integration.
Figure 6.21 – Monitor Experiment tab
Before the data can be used to solve and refine the crystal structure, it is necessary to convert the information recorded on the frames into a set of integrated intensities, and to scale all of the data.
7.1 Integration

1. Under **Integrate** in the Task Bar, click **Integrate Images**. The initial integration window opens.

![Initial integration window](image)

Figure 7.1 – Initial integration window
2. The Resolution Limit parameter in the upper right sets the upper limit of resolution for integration. The APEX2 Suite suggests a resolution cutoff. In this case, we will change the selected value to 0.75Å.

![Resolution Limit](image)

Figure 7.2 – Resolution Limit parameter

3. On the right-hand side of the window are two buttons for defining the data collection runs to be integrated.

![Find Runs and Import Runs from Experiment](image)

Figure 7.3 – Find Runs and Import Runs from Experiment buttons

The Find Runs... button is used to browse to the set of runs to be integrated. This button is normally used when the data collection is finished.

The Import Runs from Experiment button determines the runs to be integrated from the experiment that has just been submitted. Using this button allows you to start integration while the data is still being collected.

**NOTE:** When integrating while collecting data, the SAINT integration module will integrate all of the data currently measured and then wait for the next image, integrate that, wait for the next, etc.

4. Click Find Runs. The Find Runs window (Figure 7.4) opens. Usually, the Find Runs window has the correct directory and base name as the defaults. If these are not correct, then use the Browse button to find the runs for the experiment of interest.

The window pane on the right side displays all of the runs available in the current directory. Any combination of runs may be selected by simply checking the checkboxes next to the groups and clicking OK.
5. Both the **Import Runs from Experiment** and the **Find Runs** buttons generate a list of runs as in Figure 7.5.

![Find Runs window](image)

**NOTE:** To integrate runs from a CD or DVD, browse to the device and find the runs to be integrated. APEX2 will automatically write the result in the work directory for the current project.

Figure 7.6 shows a run list entry being modified. (A) shows the original run information. (B) shows the run with the starting image number changed to 51. (C) shows the number of frames to process changed to 111.

Double-click any of the fields in this list to open up the value for editing.

![Example of manually editing a run list](image)
7.1.1 Check the Refinement Defaults

Two buttons on the right-hand side of the initial integration window are used to change the default options for refinement and integration.

The default values are generally very good. There is seldom any need to change the values in the Refinement Options window.

Figure 7.7 – Refinement and Integration Options buttons

Figure 7.8 – Refinement Options window
7.1.2 Check the Integration Options

1. The Integration Options window has a few values that are changed more frequently. We will change the default options for integration in the Integration Options window.

![Integration Options window](image1)

Figure 7.9 – Integration Options window

2. Click the **More Options** button. This results in an expanded window (see Figure 7.10) and gives access to several other useful features, in particular Active Mask (see Figure 7.11), Algorithm (see Figure 7.12), and Image Queue (see Figure 7.13).

![Integration Options window (expanded)](image2)

Figure 7.10 – Integration Options window (expanded)

**Active Mask**

![Active Mask](image3)

Figure 7.11 – The Active Mask tool

The Active Mask is used to mask out areas that are covered by the beamstop, low-temp nozzle, or other obstructions. Typically a value of 0.7 is good here. SAINT will determine an active mask for each run.
NOTE: If this option is set, you should examine the active mask images that are written into the work directory with the name basename_am_##.sfrm. There is one for each run. These images can be opened with the image viewer. They should be blank except for an area in a different color showing the shape of the obstruction, typically the beamstop.

Narrow/Wide Algorithm

Figure 7.12 – The Narrow/Wide Algorithm tool

The algorithm buttons are used to change from narrow to wide frame integration. Frames collected with narrow scan widths (less than 1.5°) should be integrated as narrow frames. Those greater than 1.5° should be integrated as wide frames.

Image Queue

Figure 7.13 – The Image Queue tool

The Image Queue sets the number of frames being used to determine profiles. For crystals with high mosaic spread (i.e., large, wide reflections), increasing the queue size can improve integration.

7.1.3 Start Integration

1. Click the Start Integration button on the far right of the bottom row. This starts the integration and opens the SaintChart window (discussed in Section 7.2) for monitoring the integration.

2. Examine the output. Double-click any of the output entries (in the “Output Filename”) for one additional tool: the ls button at the far right of the line (see Figure 7.14). The ls button opens the SAINT listing file for that integration run.

Figure 7.14 – The runs list's 'ls' button
7.2 SaintChart

SaintChart is a powerful tool for monitoring the progress of the integration process and for graphically presenting the results of the integration process.

Figure 7.15 – SaintChart view
7.2.1  Monitor the Progress of the Integration

Change the text area by clicking and dragging on the line between the text and image areas. You can also expand the windows to fill the available image area by clicking **Chart > Tile** in the Menu Bar.

To the right of the image area are a series of checkboxes that select the displays. Click the checkboxes to add or remove displays.

### Average Difference

Errors in X, Y, and Z should be small (less than 1 pixel) and should not vary during the integration of a run. Large variations indicate problems with slipping crystals, misalignment of the instrument, or other problems.

### Spot Shape Profiles by Detector Region

Look for spot shapes that are well-contained within the box. Split spot shapes indicate diffraction from split crystals or twins.

### Spot Shape Correlation

the Spot Shape Correlation graph is the best indicator for a successful integration. After initial passes during the actual integration, one expects a high correlation factor at a constant level, i.e., >90% for very good crystals and >80% for good crystals. Correlation factors below 40% indicate that the orientation matrix does not describe the diffraction pattern correctly.

### Integration Progress

1. Check **Integration Progress** to add the new display seen in Figure 7.16. When the integration is complete, the blue progress bars will be full and the remaining time will be zero.

![Integration Progress display](image-url)
Spot Position Overlay

Check **Spot Position Overlay** (in the “Per-Image Statistics” category) to add a window for monitoring the progress and quality of the integration. Pull up on the Window Tool Bar for Integrated Spots to display the entire window.

In this full view, the Integrated Spots window looks much like the image viewer used previously. At the bottom of the window is an entry box that can be used to change the display frequency of the Integrated Spots images (the default is to display every fifth image).

The shape of the overlay represents the reflections’ sizes and shapes determined during the integration.
7.2.2 Examine Final Results

At the end of integration, examine this text critically. In particular, look at the Overall $R_{sym}$, the Coverage Statistics and the Unconstrained Unit Cell refinement.

1. View the SAINT text output. At the bottom of the SaintChart window is the scrolling text window that displays text output from SAINT. (This window can be expanded by dragging the horizontal bar above the text.

2. Examine the final results.
Overall $R_{\text{sym}}$ and Coverage Statistics

- The overall $R_{\text{sym}}$ is usually less than 8%. Higher values may indicate problems with absorption, twinning or poor crystal quality.

The coverage statistics are reported by resolution shells.

- The values in the $R_{\text{sym}}$ column give the cumulative agreement of equivalent reflections.
- The $R_{\text{shell}}$ values give agreement within a particular shell. These change faster than the $R_{\text{sym}}$ values.
- The $\%<2\sigma$ column is useful for checking where the weak data becomes predominant (greater than 50 or 60%).
- The $\#\Sigma_{\text{g}}$ column gives the average $I/\sigma$ for each shell. If that number is less than 1.5 or 2, then little significant data is being measured in that shell.

<table>
<thead>
<tr>
<th>Overall</th>
<th>Pairs</th>
<th>unig</th>
<th>Merg</th>
<th>$%&lt;2\sigma$</th>
<th>$\langle I \rangle$</th>
<th>$\langle #\Sigma_{\text{g}} \rangle$</th>
<th>$\langle R_{\text{sym}} \rangle$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000</td>
<td>6853</td>
<td>1259</td>
<td>1400</td>
<td>6759</td>
<td>6.3</td>
<td>5521.869</td>
<td>45.67</td>
</tr>
<tr>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2.93</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Central</th>
<th>Pairs</th>
<th>unig</th>
<th>Merg</th>
<th>$%&lt;2\sigma$</th>
<th>$\langle I \rangle$</th>
<th>$\langle #\Sigma_{\text{g}} \rangle$</th>
<th>$\langle R_{\text{sym}} \rangle$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000</td>
<td>1424</td>
<td>339</td>
<td>428</td>
<td>1370</td>
<td>13.3</td>
<td>7973.527</td>
<td>63.33</td>
</tr>
<tr>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2.67</td>
</tr>
</tbody>
</table>

Figure 7.18 – Final SAINT Overall $R_{\text{sym}}$ and coverage statistics

coverage statistics for yld om .raw

<table>
<thead>
<tr>
<th>Angstroms</th>
<th>#Obs Theory</th>
<th>%Comple</th>
<th>Redund</th>
<th>$R_{\text{sym}}$</th>
<th>Pairs</th>
<th>$#\Sigma_{\text{g}}$</th>
<th>$%&lt;2\sigma$</th>
</tr>
</thead>
<tbody>
<tr>
<td>to 1.015</td>
<td>179</td>
<td>180</td>
<td>99.44</td>
<td>7.27</td>
<td>0.019</td>
<td>178</td>
<td>98.89</td>
</tr>
<tr>
<td>to 1.283</td>
<td>332</td>
<td>332</td>
<td>100.00</td>
<td>7.30</td>
<td>0.009</td>
<td>329</td>
<td>96.10</td>
</tr>
<tr>
<td>to 1.121</td>
<td>477</td>
<td>478</td>
<td>99.79</td>
<td>7.01</td>
<td>0.021</td>
<td>472</td>
<td>96.74</td>
</tr>
<tr>
<td>to 1.019</td>
<td>618</td>
<td>619</td>
<td>99.84</td>
<td>6.61</td>
<td>0.021</td>
<td>606</td>
<td>97.90</td>
</tr>
<tr>
<td>to 0.946</td>
<td>758</td>
<td>759</td>
<td>99.87</td>
<td>6.18</td>
<td>0.021</td>
<td>745</td>
<td>96.88</td>
</tr>
<tr>
<td>to 0.850</td>
<td>890</td>
<td>910</td>
<td>99.86</td>
<td>5.85</td>
<td>0.022</td>
<td>875</td>
<td>96.15</td>
</tr>
<tr>
<td>to 0.845</td>
<td>1044</td>
<td>1045</td>
<td>99.90</td>
<td>5.56</td>
<td>0.022</td>
<td>902</td>
<td>94.93</td>
</tr>
<tr>
<td>to 0.809</td>
<td>1222</td>
<td>1246</td>
<td>99.67</td>
<td>5.10</td>
<td>0.023</td>
<td>1118</td>
<td>92.68</td>
</tr>
<tr>
<td>to 0.778</td>
<td>1324</td>
<td>1348</td>
<td>99.40</td>
<td>4.89</td>
<td>0.023</td>
<td>1220</td>
<td>92.97</td>
</tr>
<tr>
<td>to 0.751</td>
<td>1400</td>
<td>1462</td>
<td>95.76</td>
<td>4.69</td>
<td>0.023</td>
<td>1259</td>
<td>86.11</td>
</tr>
</tbody>
</table>

Overall

Coverage

Figure 7.18 – Final SAINT Overall $R_{\text{sym}}$ and coverage statistics
Unconstrained Unit Cell Refinement

Check the angles in the unconstrained unit cell refinement to get a quick confirmation that the initial lattice determination was correct. In the unconstrained refinement, angles that are required to be 90° or 120° are allowed to refine. If they differ considerably from the expected value, then the data should be checked carefully.

Unconstrained global unit cell refinement ========= 05/30/06 18:17:02
Performing final unit cell least squares on file C:\Frames\guest\ylid_example\work\ylid_01_ma
Input file contains 4525 reflections
Refinement includes 1 sample
  Sample 1 contains component 1
Global Refinement for sample 1 of 1 -- single-component data...
  Maximum allowed reflections = 9999
  One reflection will be stored in memory per 1 reflection(s) read
Orientation least squares, component 1 in sample, 1 in integration (4525 input reflections)...
  Wavelength, relative uncertainty: 0.72073000, 0.00000089
Reflection summary:
  'RLV.Excl' are reflections excluded after cycle 1 because RLV error exceeded 0.0250:
  Component Input RLV.Excl Used worstRes BestRes Min.2Th Max.2Th
1 4525  0  4525  9.1346  0.764  4.050  45.184
Orientation (deg) matrix:
  0.00000000 -0.04524600 -0.0439434
  -0.0490725  0.0572444  0.0203780
  -0.01071659  0.0686201 -0.0247583

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>Alpha</th>
<th>Beta</th>
<th>Gamma</th>
<th>Vol</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.968</td>
<td>9.037</td>
<td>18.390</td>
<td>89.997</td>
<td>90.001</td>
<td>90.002</td>
<td>990.76</td>
</tr>
</tbody>
</table>
Corrected for goodness of fit:
  0.0000  0.0003  0.0007  0.000  0.000  0.000  0.11
Crystal system constraint: Q(unconstrained)
Parameter constraint mask: 0
EulerAngles: 65.108 117.084 -134.154

Figure 7.19 – Unconstrained unit cell refinement (YLID unit cell shown)
7.3 Scale Data

The scaling process uses the SADABS program to put all of the measured data on the same scale. This process involves five steps:

- Set up input files
- Parameter refinement
- Error model refinement
- Display diagnostics
- Exit

7.3.1 Set Up Input Files

1. Under Scale in the Task Bar, click Scale. The initial Scale window appears. Figure 7.20 shows the right-hand portion of the Setup tab. The defaults and file names are typically correct.

2. Check that the defaults are correct. Generally, the Absorption Correction Type is the only value that might be changed. Numerical Absorption Correction requires indexed faces. Face indexing is discussed in Appendix B.

3. Click Next.
7.3.2 Parameter Refinement

1. Click **Refine**. Figure 7.21 shows a typical refinement result. The R-values are reduced and the Mean Weight increases. Typical final values are 3–4% for the R-values and 0.95–0.98 for the Mean Weight.

![Figure 7.21 – Scale window after refinement](image-url)
7.3.3 Error Model Refinement

1. Click **Next** to proceed to the Error Model tab, and click **Determine Error Model**. Figure 7.22 shows typical Error Model results.

![Figure 7.22 – Error Model results](image)

**NOTE:** If the R-values in one run are significantly higher than the others, you can repeat the entire scaling calculation with that run omitted. Uncheck the checkbox next to the "bad" run and then click **Repeat Parameter Refinement**.
7.3.4 Examine Diagnostics

1. Click **Finish** to produce a series of diagnostic plots. Some of these are reviews of the plots that have already been displayed.

   The diagnostics provide valuable insight into the quality of the data and possible problems with the data. Click the tabs at the bottom of the screen to view the diagnostic data.

   The **Scale Variations** plot (Figure 7.23) shows the overall variation in Scale and R(int) for the individual frames. The Scale plot should be flat (for highly absorbing, irregularly shaped crystals it will probably be sinusoidal) and the R(int) plot should not show large variations (more than 2%).

   ![Figure 7.23 – Overall Scale and R(int) variations](image)
The **Intensity Statistics** plots look at $R(int)$ and $|E^2-1|$ as a function of resolution. Typical plots of $R(int)$ versus resolution increase to the right as seen in Figure 7.24. An $|E^2-1|$ plot should have a constant value. $|E^2-1|$ is a strong indicator for centric and acentric space groups. The two horizontal lines indicate the expected values for centric (top) and acentric (bottom) space groups. This plot clearly suggests an acentric space group.

The plots of **Chi-Squared** values for the data as a function of resolution and intensity should be mostly flat. The plots shown in Figure 7.25 are typical.
The **Spatial Distribution** plots are generated for each data collection run. They indicate spots that were either stronger or weaker than expected with a deviation from the mean intensity larger than three standard uncertainties. Figure 7.26 shows two spatial distribution plots side by side. This is the way they are typically output by the scaling process.

![Spatial Distribution Plots](image)

Figure 7.26 – Spatial distribution plots
Figure 7.27 shows a single plot so that the dots are easier to see. Note that the points of disagreement are spread fairly evenly over the entire detector face.

If the spots are clustered in an area or if there are significantly more spots of one color than there are of another, then the data should be examined critically. Figure 7.28 is from another data set in which the Active Mask was not used during integration. Consequently, the reflections collected in that area are consistently weaker than expected. This kind of problem may affect the final results.
7.3.5 Exit

1. Click **Exit AXScale** to close the Scale module.

![Exit AXScale](image)

Figure 7.29 – Exit AXScale
In this step, the space group for the crystal is determined and optional simulated precession photographs are calculated to further evaluate the overall quality of the data. APEX2 provides two tools for this: **Space Group Determination (based on XPREP)** and **Precession Images** for looking at undistorted slices of reciprocal space. This is the final step before beginning the structure solution and refinement process.

### 8.1 Space Group Determination With XPREP

1. Under **Examine Data** in APEX2’s Task Bar, click **Space Group Determination**.
2. Check that the two files in the pop-up window are correct (see Figure 8.1) and click **OK**.

**Figure 8.1 – Select files for XPREP input**

**NOTE**: In this example, the integration process has created two files: ylid_example_0m.p4p containing the final unit cell parameters from integration and ylid.hkl containing the corrected intensities. Typically, these are the files to use for determining space groups, but you can browse to choose other files.
### 8.1.1 Determining Space Groups

1. **Lattice type:** XPREP evaluates the data and looks at the mean intensities and the mean int/sigma. Since these are large for all groups except P, XPREP suggests that the lattice is P (Figure 8.2). Press [Enter] to accept.

   ![Figure 8.2 – Lattice statistics](image)

   **Figure 8.2 – Lattice statistics**

2. XPREP determines the reduced cell based on the lattice entered above. Since the lattice was primitive and the magnitudes of the cell dimensions were proper (a < b < c), the original and reduced cells are the same (Figure 8.3). Press [Enter] to search for a higher symmetry cell.

3. For the YLID, no higher symmetry cell is found. The program has determined that the YLID crystal has an orthorhombic primitive lattice (Figure 8.4). Press [Enter] to accept.
4. The next logical step is to determine the space group. XPREP suggests this (Figure 8.5). Press [Enter] to determine the space group.

   ![Figure 8.5 – Determine the space group](image)

5. If the space group is known or if the compound is known to be chiral, enter that information (Figure 8.6). Generally, it is sufficient to press [Enter] to start the space group determination.

   ![Figure 8.6 – Space Group options](image)

6. XPREP has chosen the crystal system [O] (Figure 8.7). Press [Enter] to accept.

   ![Figure 8.7 – Choose the crystal system](image)

7. XPREP has chosen the crystal lattice [P] (Figure 8.8). Press [Enter] to accept.

   ![Figure 8.8 – Choose the lattice](image)

8. XPREP evaluates the data and looks at the systematic absences for all possible glide planes and screw axes (Figure 8.9). These are displayed across the middle of the figure. By examining the number of reflections with I > 3 sigma(I), the mean intensities, and the mean int/sigma, which should all be very small for a systematic absence, XPREP derives a suggested space group, P2(1)2(1)2(1). Press [Enter] to accept.
8.1.2 Reflection Statistics

Systematic absences:

<table>
<thead>
<tr>
<th>h</th>
<th>k</th>
<th>l</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>7</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>8</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>9</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>11</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>12</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>13</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>14</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>15</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>16</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>17</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>18</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>19</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>21</td>
</tr>
</tbody>
</table>

3. The data can be merged in several ways. Choose the “Merge ALL equivalents including Friedel opposites” option [A] (Figure 8.11). Press [Enter] to accept.

NOTE: This merge will not average the reflections in the final data file. It is only for the calculation of statistics.

Figure 8.11 – The merge data menu

<table>
<thead>
<tr>
<th>Data</th>
<th>S-data</th>
<th>User name or Source of Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>11249</td>
<td>yild.hl</td>
</tr>
</tbody>
</table>

Select option [A]:

Figure 8.10 – The data manipulation menu

A table of statistics appears (Figure 8.12). Examine the data presented. Is the completeness near 100%? Is the redundancy good? Are $R_{int}$ and $R_{sigma}$ small and increasing smoothly from top to bottom? In particular, look at the last two lines which compare all of the data with the high-resolution data. The completion should be near 100% for both the high-resolution shell and the complete data set. The redundancy and $R_{int}$ should be similar for the two. The Mean Intensity and the Mean $I/\sigma(I)$ will usually be quite different. The Mean $I/\sigma(I)$ for the high-resolution data should be greater than 3.0.
5. Press [Enter] to continue.

6. Press [Enter] again to exit to the main XPREP menu.

8.1.3 Preparing an Output File

1. In the general menu, choose [C] to define the unit cell contents.

A window opens displaying the current formula, Z, the density, and the atomic volume (see Figure 8.13). In this example, the formula is incorrect and Z has been set to six to try to achieve a reasonable density and atomic volume. Since this formula is incorrect, it must be modified now. The correct chemical formula for the YLID crystal is C11H10O2S.

2. At “Select option”, do not accept the default answer of E. Type in [F] to enter a new formula.

3. In response to the question “Enter Formula,” type the correct formula [C11 H10 O2 S] and press [Enter].

4. Check that the information is correct. Check that Z seems reasonable for the space group, that the density is as expected (1.1 to 1.4 for organic molecules, higher for inorganic compounds), and that the atomic volume is around 17 or 18. Significant variation from the expected values may indicate an incorrect molecular formula or missing counter ions or solvates. The values at the bottom of the window look fine for the YLID. Press [Enter] to accept.
5. The next default action for XPREP is to write out the files necessary for the structure solution process (see Figure 8.14). Press [Enter] to accept.

6. The program asks for an output file name. Press [Enter] to accept.

7. After entering the file name or pressing [Enter] to accept the default file name, an input file for the structure solution module is created and displayed on the screen, and the program asks, “Do you wish to (over)write the intensity data file ylid_manual_0m.hkl?” Since the file name has been changed, this question must be answered with a “y” (see Figure 8.16).
8. Exit XPREP (see Figure 8.17). Press [Enter] to exit the program.

NOTE: There are many other features in XPREP that can be accessed from the general menu: resolution cutoff, reciprocal space plots, simulated powder patterns, and a test for merohedral twinning are very useful tools.
3. Check the default input value. Modify as needed and press **Calculate**.

Calculating more zones does not significantly increase the calculation time. In the example, 1kl, h1l and hk1 have been added to the defaults of 0kl, h0l and hk0. Fractional values (e.g., 0.5kl) are allowed. Reducing the resolution may speed the calculations slightly. The thickness defines the range of pixels above and below the requested range. For example, if the 0kl zone is requested with a thickness of 0.1, then the simulation is looking for all pixels that have \(-0.1 < h < 0.1\), and any value (including fractional values) for \(k\) and \(l\).

4. A progress bar appears (Figure 8.20) and after approximately 5-10 minutes (depending on the number of “.sfrm” files read) the simulated precession image will appear on the screen. Display other planes by clicking on the calculated images to the bottom right of the work area or by browsing as usual with the **View** module.

5. Use the simulated patterns to check space group symmetry (see Figure 8.21, Figure 8.22, and Figure 8.23) and to find signs of twinning (Figure 8.24).
Figure 8.21 – The 0kl plane for the test YLID

Figure 8.22 – The h0l plane for the test YLID
Figure 8.23 – The hk0 plane for the test YLID

Figure 8.24 – A plane from a rotationally twinned crystal showing the two lattices
9 Structure Solution and Refinement

9.1 Overview

You are now ready to solve and refine the crystal structure. The various steps in solving and refining the structure are carried out within the APEX2 GUI. XPREP has prepared the input files for a standard direct methods run. There are two files: .ins and .hkl. In this example, the two files are ylid_0m.ins and ylid_0m.hkl. These files are all that is required to begin the structure solution and refinement process. The various steps of solving and refining the structure are carried out using the **Solve** and **Refine** functions of the APEX2 Suite.
9.2 Solve the Structure

The process of obtaining an initial model of the compound is started by clicking in the Task Bar on Solve Structure and then on Structure Solution. This opens the Structure Solution module.

Check that there is a reasonable formula in the formula window.

1. If you have a correct formula in the formula field, then you are ready to start a normal direct methods run.
2. If the formula is incorrect, change it and press [Enter]. The input file will be updated.

Figure 9.1 – Default Solve Structure view
3. Click **Solve Structure** to start the direct methods calculations. The upper window displays the Q-peaks of the initial model, and the text area displays the progress of the calculations.

### 9.2.1 Options for Direct Methods

Clicking on the arrow to the right of Direct 1 in the Method box (Figure 9.3) gives three preset choices for structure solution using direct methods.

![Method box](image)

In most cases the default values will give a good initial model, but several other options are available for more difficult problems. Chose the solution method by clicking the appropriate radio button on the left in the Method box.

![Structure Solution output](image)
At the end of the direct methods runs, the output display will look like Figure 9.2. Good figures of merit are near 1.0 for Sigma-1 and M(abs) and less than 0.06 for R_alpha and the CFOM. Structures can be solved with figures of merit that deviate from these numbers, but they may require more effort.

If the initial model looks reasonable, click OK in the output display and Exit in the Structure Solution module. APEX2 automatically switches to the Display tab and displays the initial solution. The next step is structure refinement using XShell (Section 9.3).

### 9.2.2 Options for Dual Space Methods

Two predefined options are available for the Dual Space method.

Dual Space methods are good for larger organic molecules and polypeptides.

More information on Dual Space methods and their use within APEX2 is available from the "What's This?" Help function.

### 9.2.3 Options for Patterson Methods

Two predefined options are available for Patterson methods.

Patterson methods are good for finding heavy-atom positions. In general, Patterson methods favor a small number of strong scatterers.

More information on Patterson methods and their use within APEX2 is available from the "What's This?" Help function.

<table>
<thead>
<tr>
<th>Preset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct 1</td>
<td>Standard settings which should be appropriate for a wide range of circumstances. Sets up a default run with a simple TREF instruction.</td>
</tr>
<tr>
<td>Direct 2</td>
<td>Brute force method with a higher number of direct methods attempts. Sets up an extended run with TREF 10000. By adding 10000 to the TREF command, more attempts are made to determine a solution. This will take more time, but if you see a good solution in the output window it is possible to stop at that point by clicking on the STOP button. Good solutions typically have a CFOM of 0.06 or less.</td>
</tr>
<tr>
<td>Direct 3</td>
<td>Brute force method with even more direct methods attempts. Sets up an extreme run with two instructions: ESEL 1.0 and TREF 100000. By adding ESEL 1.0, more reflections are used in the solution process. Increasing the number of tries in the TREF command to 100000 runs (until ended by clicking on the STOP button) is particularly useful for acentric triclinic structures and for pseudo-symmetric structures.</td>
</tr>
</tbody>
</table>

Table 9.1 – Direct Methods presets
9.3 Refine the Structure with XShell

The structure solution step produced statistics indicating that a solution had been found. The real proof, however, is in the initial model that is produced. XShell provides the tools to view and refine the model. A quick glance at the results of the direct methods run is often all that is needed to see that the results make chemical sense.

Control of the refinement process is quite straightforward using XShell.

1. Under Refine Structure in APEX2's Task Bar, click the Structure Refinement icon.

This opens the Structure Refinement module, which contains tabbed sections for viewing the instructions file, listing file, results file, and a 3D model of the structure.

Figure 9.4 – Structure Refinement module initial view
2. Click the **Browse** icon on the right-hand side of the “Base:” field. A dialog opens in which you can select the desired .ins file.

![Open file dialog](image)

Figure 9.5 – Open file dialog

3. Click **Open**. The contents of the .ins file and any other files with the same base name are displayed under their respective tabs. Also, the six buttons in the lower right-hand corner of the module become available.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Files</td>
<td>Refresh the tabs using the absolute latest contents of all the files.</td>
</tr>
<tr>
<td>Copy RES to INS</td>
<td>Copies the contents of the results file into the instructions file.</td>
</tr>
<tr>
<td>Save Files</td>
<td>Saves any changes you have made to the files.</td>
</tr>
<tr>
<td>Refine with XL</td>
<td>Refines the instruction file using XL.</td>
</tr>
<tr>
<td>Open in XP</td>
<td>Opens XP for editing the results file.</td>
</tr>
<tr>
<td>Open in XShell</td>
<td>Opens the selected file in XShell.</td>
</tr>
</tbody>
</table>

Table 9.2 – Structure Refinement module buttons
4. **Click Open in XShell.** The XShell Main Window appears.

![Figure 9.6 – Initial view of the YLID molecule](image)

Figure 9.6 – Initial view of the YLID molecule
5. Right-click in the background to open a pop-up window with image display options.

6. Select the **Information on All Atoms** option to open a window displaying a list of the peaks and their heights (see Figure 9.8). The drop in height between Q13 (the last real peak) and Q14 (the first noise peak) is typical of a correct solution. Click **OK** to close this window.

![Figure 9.8 – Atom information screen](image)

At the bottom right of the main window is a slide bar which is used for deselecting peaks. The arrow can be moved by left-clicking and dragging the arrow or by left-clicking on either side of the arrow. Left-clicking to the left of the arrow (i.e., where the mouse cursor is pointed in Figure 9.9) removes peaks.

![Figure 9.9 – The Q-peak slider](image)
7. Slide the pointer down while watching the molecular display. Change the number of Q-peaks to 15. At 15 the molecule is much cleaner, but there are still peaks that do not make sense.

Figure 9.10 – Image after the number of Q-peaks was changed to 15

Click left on the slider until you find a reasonable model.

8. Put the cursor over the bonds to check distance. The distance is displayed at the bottom right.

Figure 9.11 – Image with all noise peaks removed
9.3.1 Label the Atoms

1.  Label the atoms and set the atom types. Left-click atoms to select them. Left-click the peaks for the two oxygen atoms (Q2 and Q5 in this example).

   ![Figure 9.12 – View of model with the probable oxygen peaks selected](image)

2.  If it is difficult to see the color and labels, change the color scheme with Preferences > Background Color. Choose colors and click Apply. Click Cancel to exit the background color mode. Note that the selected peaks are blue in Figure 9.14.

   ![Figure 9.13 – Selecting the background color](image)

   ![Figure 9.14 – New background color](image)
3. Right-click to view a pop-up menu and select **Labelling**. The Atom Labelling box opens.

![Figure 9.15 – Select Labelling](image)

![Figure 9.16 – Atom Labelling box](image)

4. The two selected atoms need to be changed to oxygen atoms. Do this one of two ways:
   - Click the Element field and type in the element symbol (case does not matter).
   - Click the **El** button to the right of the Element field to open a periodic table. Click the appropriate element symbol to select it (the periodic table will automatically close).

![Figure 9.17 – The periodic table for selecting atom types](image)

5. Once the element type is set correctly, click **Relabel** to number the peaks sequentially in the order they were selected, starting with the number in the First Sequence # field.
6. Seeing the color of atoms can be difficult in the Wireframe view used so far. Right-click in the background with no atoms selected to get a slightly different action menu. In this menu, highlight and left-click **Pipes**. This makes the bonds thicker and makes it obvious that there is an incorrectly labeled atom. This will be corrected when the carbon atoms are labeled.

7. Click on the remaining peaks in the order that you want them labeled.

**NOTE:** If working on YLID test data, look at Figure 9.19 and click on the peaks to give the same order as used here. Right-click and select **Labelling**. Select Carbon and apply the labels.

8. In the Labelling tool, change the element type to C (carbon). The starting atom number changes to 1—the first available number for carbon atoms.

9. Click **Relabel**.

10. Click **Cancel** to close the window. The labeled YLID molecule is now ready for refinement.
9.3.2 Refine the Model

1. Click the **Refine** button in the Tool Icon Bar (the cursor is pointing to it in Figure 9.20), type [Ctrl+R], or select **Refine > Refine** in Xshell's Menu Bar. This opens the Refine Box.

![Figure 9.20 – The Refine icon](image)

2. Click **Refine** to launch XL (the least-squares refinement program) using the default parameters as given in Figure 9.21.

![Figure 9.21 – The Refine menu](image)

After a few seconds, a Refine window will open with output results for the calculation.
In the output displayed above, note that the $R_1$ value is 0.09. This is typical for a preliminary isotropic refinement for an organic molecule with data to a resolution of 0.75 and no hydrogen atoms included. The refinement program also indicates that the model needs to be inverted to get the correct absolute structure.

**NOTE:** This indication of the absolute configuration is usually reliable, but all assignments of absolute structure should be confirmed later in the refinement process by including TWIN and BASF cards in the instruction input.
4. In the refinement box, click **Invert Structure** and **Refine All Non-H Atoms Anisotropically** as in Figure 9.24.

![Image](image1.png)

Figure 9.24 – Inverting and choosing anisotropic refinement

5. Click the **Refine** button to launch the least-squares refinement program. The output window opens and a summary of the results of individual cycles of refinement appears.

![Image](image2.png)

Figure 9.25 – Least-squares refinement summary

The value for R1, 0.0459, is typical for an initial anisotropic refinement with no hydrogen atoms included. Since the mean shift/esd is greater than 0.1, the model is still changing. Since the highest peak in the difference map has a height of 0.47 and is 0.97Å from C10, there are certainly some hydrogen atoms to be included.

Examination of the difference peaks in the resulting difference electron density map shows that the top difference peaks all correspond to hydrogen atoms.

![Image](image3.png)

Figure 9.26 – Difference peaks correspond to expected hydrogen atom positions
9.3.3  View Atomic Displacement Parameters (Thermal Ellipsoids)

It is generally good practice to examine the displacement parameters at this point in structure determination.

1. Remove difference peaks with the slider tool.

   ![Removing all Q-peaks with the slider bar](image1)

   Figure 9.27 – Removing all Q-peaks with the slider bar

2. Right-click on the background and select Thermal Ellipsoids.

   ![Selecting Thermal Ellipsoids](image2)

   Figure 9.28 – Selecting Thermal Ellipsoids

Alternatively, a list of Ueq's (equivalent isotropic displacement parameters) can be generated by requesting information on all of the atoms. Examining these values for outliers is good practice.

3. Right-click on the background and click Information on All Atoms.

   ![Selecting Information on All Atoms](image3)

   Figure 9.30 – Selecting Information on All Atoms

This produces the table in Figure 9.31.
Figure 9.31 – List of parameters with Ueq to the right

Examining the values here is difficult because the atoms are not in order.
9.3.4 Sort Atoms

1. Right-click on the background and click **Sort...** to sort the atoms into a sensible order.

   ![Sort option](image)

   Figure 9.32 – Select the Sort option

   An Atom List box appears to the right of the molecule display. Since S1, O1 and O2 are in a reasonable order, only the carbon atoms need to be ordered.

   ![Sort Bin](image)

   Figure 9.33 – Selecting carbons for sorting

   **NOTE:** Generally, it is easier to sort and number atoms before adding hydrogen atoms.

2. Highlight the atoms to be sorted (i.e., left-click and drag over the atoms) and move them to the Sort Bin (i.e., click **Move Selected Atoms to Sort Bin**).
3. After the atoms are in the Sort Bin, click **Sort(Alpha-Numeric)** to get them into a normal order.

4. Highlight O2 and click **Insert All After** as in Figure 9.35.

5. Click **OK** to accept the sorting.

The resulting list of atom information is easier to examine.
The Ueq values are reasonable if there are:

- lower values for the sulfur atom and the five-member ring
- higher values for the terminal atoms — methyls and carbonyls
- sensible numbers for the six-member ring — lower for C8 and C9, higher for C5 and C6, and in between for C4 and C7.

### 9.3.5 Add Hydrogen Atoms

At this point, refine the hydrogen atoms either by renaming the Q-peaks using the Labelling tool as before and then including them in the refinement, or include the hydrogen atoms in fixed idealized positions riding on the atoms to which they are attached.

In this User Manual we will illustrate the latter fixed idealized method.

**NOTE:** In some cases (e.g., hydrogen atoms on hetero atoms or on geometrically strained carbon atoms), it is better to refine the hydrogen atom positions. A general rule is to refine if there is some doubt about the position of the hydrogen atom and there is difference electron density present.

1. Using the slider tool, remove all of the Q-peaks.
2. Right-click on the background and click **Add Hydrogen atoms > Hybridize All**.

![Hybridize button](image)

Figure 9.39 – Hybridize button

The colors of the atom labels change to indicate the atom hybridization.

**NOTE**: If the atom hybridizations are hard to see, right-click on the background and open the Information on All Atoms window.

3. Right-click in the background and click **Add Hydrogen atoms > Calculate Hydrogens**.

![Calculate Hydrogens button](image)

Figure 9.40 – Calculate Hydrogens button

4. A warning appears indicating that the hydrogen atoms have been provisionally added and that the final addition with naming will take place when the least-squares calculations are started (Figure 9.41). Click **OK**.

![Hydrogen atom warning](image)

Figure 9.41 – Hydrogen atom warning

![Model with added hydrogen atoms](image)

Figure 9.42 – Model with added hydrogen atoms
5. **Click the Refine button** to launch the least-squares refinement program. The output window opens, and a summary of the results of individual refinement cycles appears.

![Figure 9.44 – Difference peaks in a well-refined model]

The value for R1, 0.0281, is typical for an anisotropic refinement with riding hydrogen atoms and a data set measured to 0.75Å. Since the mean shift/esd is less than 0.01, the model is not changing significantly. Since the highest peak and the deepest hole in the difference map are similar, there are probably no missing atoms.

The resulting difference electron density map appears rather ugly. This is because the number of difference peaks to be displayed has been set at 20.
9.3.6 Final Refinement for Publication

Obtain a view that is much easier to interpret by reducing the number of difference peaks in the Refine menu (see Figure 9.45).

1. For the final cycles of refinement, reduce the number of peaks to be displayed to five and turn on “Use Suggested Weights” and “Generate ACTA(CIF) Information File” as shown in the next two figures.

**NOTE:** If the suggested weights vary significantly from 0.06 and 0.00, then change the values to 0.06 and 0.00.

Figure 9.45 – Reduce the number of difference peaks

Figure 9.47 shows a difference map with the number of peaks set at five.

Figure 9.46 – Select weights and request ACTA output

2. Click **Edit File**, choose *.INS and click **OK** to open the instruction file for XL. This allows you to add instructions that are not directly available in the GUI.

Figure 9.48 – Open the .ins file for editing

3. Check that the temperature card is correct.
4. If torsion angles are of interest, add a CONF (confirmation) card (see Figure 9.49).

5. If planarity and angles between planes are of interest, add mpla cards.

9.3.7 Generate an Atomic Displacement (Thermal Ellipsoid) Plot

1. Remove difference peaks with the slider tool.

2. Right-click on the background and select Thermal Ellipsoids.

3. If the hydrogen atoms in Figure 9.50 are large, change their sizes by going to Preferences > Atom Preferences... in XShell's Menu Bar.
At the top of the box that is opened, there are three values that can be changed to adjust the size of atoms and the bonds to them.

4. Change the hydrogen radius to 0.08 and the bond radius to 0.15 to make the hydrogen atoms smaller. Click **Apply**.

5. Position atom labels by right-clicking on the atom and choosing **Position Label**.

6. Convert this image into a high-quality .jpg file for inclusion into reports by clicking **Render** in the Windows Tool Bar and choosing **Color > To High Quality JPEG File**.
NOTE: A message may appear that the font file needs to be defined: “Please set your font directory for the first time for opengl rendering.” If this happens, click Preferences > OpenGL Preferences and click on the TrueType font For.OpenGL.

In Windows, browse to C:\\bn\\xshell\\fonts\\

In Linux, navigate to /usr/local/bin/xshell/fonts. Choose a font.
Appendix A  RLATT

RLATT is a very powerful tool for viewing the harvested reflections in a reciprocal lattice. This Appendix covers only a few of its features. More information on RLATT is available in M86-Exx045 RLATT User Manual.

This example has over 3300 reflections. This is not the typical case; generally only 300 or 400 reflections are examined. Using extra reflections will make the examples easier to see.

A.1  Open RLATT

1. Under Evaluate in APEX2’s Task Bar, click Reciprocal Lattice Viewer. RLATT (The Reciprocal Lattice Viewer module) opens.

2. RLATT will automatically read in the reflections from the current project and display them as a reciprocal space plot.

Figure A.1 – RLATT icon
Figure A.2 is a typical unoriented view after import. The gray circles are more intense reflections, i.e., those with higher $I/\sigma(I)$. The black dots represent less intense reflections. The intensity key slider at the bottom of the window can be used to change the selection criterion.

![Unoriented RLATT view](image)

Figure A.2 – Unoriented RLATT view

Other tools can be accessed by right-clicking on the background to give the "Quick Tools" menu (Figure A.3) and by clicking on RLATT in the menubar (Figure A.4).

![Quick Tools menu](image)

Figure A.3 – Quick Tools menu

![Full menu tools](image)

Figure A.4 – Full menu tools

Additional context-sensitive information is available by left-clicking on the "What's This" help arrow in the menu bar.

![What's This help arrow](image)

Figure A.5 – The "What's This" help arrow

For example, clicking on the help arrow and then clicking in the work area (the gray area to the right of the lattice display) gives the display of shortcuts shown in Figure A.6. Clicking on the blue background gives the hints shown in Figure A.7.
### RLATT Keyboard Commands

<table>
<thead>
<tr>
<th>Rotate &amp; Zoom</th>
<th>Orientation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>UP / DOWN</td>
<td>F1 = 1 0 0 (along a*)</td>
</tr>
<tr>
<td>LEFT / RIGHT</td>
<td>F2 = 0 1 0 (along b*)</td>
</tr>
<tr>
<td>INS / DEL</td>
<td>F3 = 0 0 1 (along c*)</td>
</tr>
<tr>
<td>+ / -</td>
<td>F4 = unoriented (identity matrix)</td>
</tr>
<tr>
<td>hold SHIFT</td>
<td>F5 = user-defined orientation 1</td>
</tr>
<tr>
<td>hold CTRL</td>
<td>F6 = user-defined orientation 2</td>
</tr>
<tr>
<td>hold SHIFT + CTRL</td>
<td>F7 = user-defined orientation 3</td>
</tr>
<tr>
<td>hold SHIFT + CTRL</td>
<td>F8 = user-defined orientation 4</td>
</tr>
<tr>
<td>Selection Tools:</td>
<td>SHIFT + F5 = store user-defined orientation 1</td>
</tr>
<tr>
<td>SHIFT + left-click</td>
<td>SHIFT + F6 = store user-defined orientation 2</td>
</tr>
<tr>
<td>CTRL + left-click</td>
<td>SHIFT + F7 = store user-defined orientation 3</td>
</tr>
<tr>
<td>UP, DOWN, LEFT, RIGHT</td>
<td>SHIFT + F8 = store user-defined orientation 4</td>
</tr>
<tr>
<td>hold SHIFT</td>
<td>= 4x speed (during movement only)</td>
</tr>
<tr>
<td>hold CTRL</td>
<td>= 10x speed (during movement only)</td>
</tr>
<tr>
<td>hold SHIFT + CTRL</td>
<td>= 16x speed (during movement only)</td>
</tr>
<tr>
<td>hold SHIFT + CTRL</td>
<td>= 64x speed (during movement only)</td>
</tr>
<tr>
<td>+ / -</td>
<td>= add slice (lattice tool only)</td>
</tr>
<tr>
<td>PGUP</td>
<td>= add segment (lattice tool only)</td>
</tr>
<tr>
<td>PGDN</td>
<td>= remove slice (lattice tool only)</td>
</tr>
<tr>
<td>ALT + left-click</td>
<td>= lock onto spot (lattice tool only)</td>
</tr>
<tr>
<td>Mouse:</td>
<td></td>
</tr>
<tr>
<td>[</td>
<td>= adjust intensity slider</td>
</tr>
<tr>
<td>]</td>
<td>= adjust intensity slider</td>
</tr>
<tr>
<td>A</td>
<td>= change atom modes</td>
</tr>
<tr>
<td>C</td>
<td>= change colorization method</td>
</tr>
<tr>
<td>I</td>
<td>= insert selection</td>
</tr>
<tr>
<td>M</td>
<td>= toggle distance measurement during lattice selection tool</td>
</tr>
<tr>
<td>N</td>
<td>= toggle Null Resolution Mode</td>
</tr>
<tr>
<td>S</td>
<td>= change 2D Projection Scale mode</td>
</tr>
<tr>
<td>U</td>
<td>= toggle Unit Cell Tool</td>
</tr>
</tbody>
</table>

Figure A.6 – Shortcut keys and commands
3D Reciprocal Lattice View

In this window is the three-dimensional display of the reciprocal lattice using OpenGL for hardware rendering.

Left-click and drag to rotate the view or use a selected feature.

Double-left click on a reflection to bring up a little statistics window. Click on the statistics window to make it disappear.

Middle-click and drag to change the zoom ratio.

Spin the mouse wheel to adjust the reflection sizing.

Right-click to make a quick-menu of special features available.

Figure A.7 – Help for the 3D display obtained by clicking the “What's This” arrow on the blue display background
A.2 Orienting Views

Move the mouse to rotate the RLATT display. It is possible to easily see rows and non-fitting peaks (see Figure A.8).

By sliding the intensity key at the bottom of the display, it is easy to deselect weak reflections. In Figure A.9 the reflections between the layer lines all go black when the intensity filter is moved to the left.
With additional rotations, the layers of reflections can be further oriented so that stacks of reflections become visible. Sometimes it is quite useful to right-click on the background and choose Z-rotations from the rotation options. The 2D profiles on the top and to the left are a valuable aid in this process. With practice, the 2D profiles can be organized into clusters. As shown, the 2D profiles are counting intensity. The counting mode can be changed to spot count or turned off completely using the Visualization menu (RLATT > Visualization) or by pressing the [s] key to cycle through the counting modes.

Figure A.10 – An oriented lattice view. The Visualization menu is to the right. The 2D profiles are to the left and to the top.
The distance between layers can be measured by clicking on one of the clusters of lines in the 2D view and then dragging to the next cluster. If you drag over three clusters, then the distance as measured would need to be multiplied by three.

Figure A.11 – RLATT display with measured distances in the 2D views.

The Orientation menu allows easy orientation if the cell is indexed. Press the [F1], [F2], or [F3] key or click the appropriate button.
Figure A.12 – An aligned image with the Orientation menu to the left
3. Select reflections with the Lattice tool.

The Lattice tool is one of the most useful editing tools. Activate it from the Edit menu or by clicking on the background and choosing Select > Lattice. When initially activated, nothing appears. Hold down the [Alt] key to lock on a centroid and then left-click and hold on a spot. Now drag the mouse and line up the line that is tied to your spot on a row. Choose a longer row and align carefully. Now, while still holding the left mouse button, drag the second line to another row as shown in Figure A.13. Let go of the button. If you want to start over, click on another spot and repeat the process. Using the [Alt] key is optional, but it makes alignment of the lines easier and more accurate (Linux users may find that the [Alt] key has operating system functions).
Figure A.13 – Two lattice lines selected
Press the [+] key to add lines between the two you have marked. Press the [-] key to remove lines.

Figure A.14 – View with most of the lattice lines selected. Lines to the top and bottom are not selected.
Use the [Page Up] key to add lines to the outside of the previously selected lines (in this example, the top and bottom). [Page Down] removes lines from the outside. Now all visible lines are selected. Note that the selected reflections are turquoise.

Figure A.15 – A view with all layers selected
Click **Invert Selection** (in the “Editing Menu” (RLATT > Edit) under “Selection Helpers”). All of the spots that do not touch the layer lines are now selected.

Figure A.16 – The selected spots are now the little ones between the layers. The spots in the layers are grey and the selected spots are turquoise.
Click **Delete Selected (finalized at save)** to mark the selected reflections to be deleted (and turned black). Alternatively, these selected reflections can be added to a group and then hidden using “Select Visible Groups.”

Figure A.17 – Selected reflections are blacked out
Save the file by clicking the disk icon (Figure A.18) or use **File > Save** to remove the reflection from the reflection list. Hiding a group with “Select Visible Groups” does not remove it from the reflection list. Either way, the resulting RLATT image is much cleaner and easier to interpret (Figure A.19).

![Save File icon](image)

Figure A.18 – Save File icon
Enable the Unit Cell tool to put a colored box in the view. This allows you to see if reflections are actually falling on the corners of the box (see Figure A.19 and Figure A.20). There are multiple options in the Unit Cell tool. “Select a Visible Plane” displays individual planes. “Select Plane Size” determines the boundaries of the planes and the number of unit cells displayed. Grid Planes mode displays planes as grids with spacings determined by the lattice.

Figure A.19 – A view of the reciprocal lattice after the non-fitting reflections were deleted and with the Unit Cell tool enabled.
Figure A.20 – A view that zooms in on the Unit Cell tool. Almost all spots lie on the lines and planes defined by the unit cell. To the left and right are two weaker reflections (black dots) that do not fit.
A.3  Defining Groups

Selected reflections can be grouped. This tool is most useful for examining twinned, split, ingrown and otherwise problematic crystals. For Figure A.21, alternate rows were selected with the Lattice Selection tool. In the Grouping Tools section of the tool boxes to the right, the current group was set to Group 1 (red). Click “Add to Current Group” to turn these rows red. Then, the other rows and Group 13 (white) were selected and added. The box tool was used to select the reflection to the top left and these were put in Group 3, the yellow group. Finally, some of the reflections to the top and bottom were selected and added to Group 5, the blue group. This example of using the color groups generates a flag-type display. For twinned crystals, etc., the groups would be used to denote different components (see Figure A.22).

![Reflections selected for different groups](image-url)
Figure A.22 – A more practical use of the selection and color groupings in RLATT. The two components of a rotational twin are colored yellow and red.
A.4 Measuring Distances and Angles

Right-click on the background and choose Measure to get tools for measuring distances and angles.

The Measure Distance tool gives two lines, much like the lines in the Lattice Selection tool, that can be oriented and dragged to get lattice spacings (see Figure A.23). Use the [Alt] key to lock on spot centers for easier orientation and more accurate measuring.

Figure A.23 – Using the Measure Distance tool
With the Measure Angle tool, left-click, hold, and drag a line on a lattice layer ending on the spot that will become the vertex of the angle. When the mouse is released, that point becomes the pivot point for a new line. Moving the mouse with no buttons depressed gives angle measurements (see Figure A.24). As described, the angle measurements will be done in 2D mode (i.e., the angle between the two lines displayed). To measure an angle in 3D mode, hold the [Alt] key while selecting spots as above. The tool will then lock on to spot centroids and the angle will be calculated using spot coordinates. This eliminates errors that might result from measuring using the 2D projection of the current orientation.

Figure A.24 – Using the Measure Angle tool
A.5 Writing a .p4p File

At the bottom of the Edit menu, there is a button for exporting all visible reflections to a .p4p file. The .p4p file is a text file of crystal, instrument, and reflection information. If the cell and crystal orientation is known, that information is included also (otherwise, dummy values are included). The sequence of cleaning up a set of reflections using RLATT and then exporting the results for input to CELL_NOW is a useful tool for dealing with hard-to-index crystals.
Appendix B  Face Indexing

In order to correct intensity data for absorption numerically, the crystal's faces must be indexed. This allows a very exact crystallographic description of the crystal's shape.

Once you have a unit cell for your crystal, the Face Indexing module allows you to define faces directly over images of the crystal. As you define more and more faces, APEX2 automatically determines the dimensions of the crystal.

The examples in this Appendix use a large crystal for which the unit cell has already been determined.

B.1  Start the Crystal Faces Module

1. From the Scale category in APEX2's Task Bar, select Crystal Faces.
B.2 Collect a Video Zip Stream

To index the faces, first collect a video zip stream, which is a series of images taken with the video microscope as the crystal is rotated through 360° about the phi axis.

**NOTE:** For the best results, make sure that lighting conditions are optimal for the crystal you are viewing. If possible, try to illuminate the crystal for optimum contrast between the crystal and the background. Also, it may desirable to use multiple light sources to illuminate several faces simultaneously.

1. If no video zip stream has been collected for this crystal, a dialog appears prompting you to acquire a new video zip stream or load an existing one.

2. Because we have not yet taken a video zip stream for this crystal, click **Acquire New**. A save dialog box (defaulted to your current project directory) appears.

3. Click **Save**. If VIDEO is not open, it will open with a progress bar showing the video zip stream collection. When the video zip stream is fully collected, the Face Indexing initial view will appear (Figure B.4).
B.3 Using the Face Indexing Module

The Face Indexing module uses a dial at the bottom of the screen to step through the images of the crystal, and a tool called the T-tool to define faces. The Face List, shown on the right, displays the faces you have defined for the crystal and their distance from the instrument center.

Figure B.4 – Face Indexing: Initial View
B.3.1 Set View Options

Depending on the color and reflectivity of the crystal and background, you may want to adjust the display colors.

1. Right-click in the image display area and select **Configure Overlay** from the menu. The Overlay Configuration menu appears (Figure B.5).

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show T-tool</td>
<td>Show and hide the T-tool for a better view of the crystal faces.</td>
</tr>
<tr>
<td>Max. Miller index:</td>
<td>The highest Miller index shown as face normals in the overlay.</td>
</tr>
<tr>
<td>Max. out-of-plane angle (deg):</td>
<td>When the T-tool snaps to a face normal, the plane you define may differ from the specified index by a maximum of this amount.</td>
</tr>
<tr>
<td>Show possible face normals</td>
<td>APEX2 suggests face normals.</td>
</tr>
<tr>
<td>Snap to possible face normals</td>
<td>The T-tool snaps to the suggested face normals.</td>
</tr>
<tr>
<td>Dial (or mouse wheel)</td>
<td>Use the dial to rotate around 360° of phi. The right-click menu lets you rotate phi by 180° to define parallel faces.</td>
</tr>
<tr>
<td>Crystal face information</td>
<td>Shows the Miller indices of a given face, the face's distance from the instrument center, and the out-of-plane angle.</td>
</tr>
</tbody>
</table>

Table B.1 – Face indexing controls

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Cell</td>
<td>Displays the unit cell that APEX2 uses to display faces in the overlay.</td>
</tr>
<tr>
<td>H,K,L</td>
<td>Miller indices of the normal to the specified face.</td>
</tr>
<tr>
<td>Distance (mm)</td>
<td>The specified face's distance to the center of the instrument.</td>
</tr>
<tr>
<td>Remove Invisible Faces</td>
<td>Faces obscured by the body of the crystal are removed from the Face list.</td>
</tr>
<tr>
<td>Closed:</td>
<td>Displays whether the faces you have defined encapsulate a closed volume.</td>
</tr>
<tr>
<td>Size (mm):</td>
<td>Dimensions of the crystal, calculated according to the defined faces.</td>
</tr>
</tbody>
</table>

Table B.2 – Face list

![Overlay Configuration menu](image)
B.3.2 Specify Crystal Faces

1. Use the dial control at the bottom of the screen (or use the mouse wheel) to rotate the crystal until one of the faces is parallel to the microscope axis as in Figure B.6. Note that, because Show T-Tool and Show possible face normals are selected, APEX2 suggests possible faces (whose indices are within the Max. Miller Index parameter) with dotted lines.

2. Move the mouse cursor to the dotted line that is perpendicular to the face. The mouse cursor snaps to the possible face normal.

3. A line appears to show the possible face. This line defines a plane along the microscope axis, which should be parallel to the crystal face. Use the mouse to move the line until it touches the crystal face.

4. Click to fix the face. An entry appears in the Face List showing the Miller Indices of the crystal face, along with the face’s distance from the instrument center.
5. Repeat all steps in this section to specify all of the crystal’s visible faces. If APEX2 does not suggest a face normal for a certain face, you can increase the value in the Max. Miller index field to show more suggested normals.

6. As you define more faces, APEX2 will begin to display its geometric model of the crystal, superimposed over the video images (Figure B.9). Continue until all faces are defined.
B.3.3 Editing the Face List

Consider Figure B.11. The face (1 3 -2) does not appear to define a face correctly. Removing this face will give a more accurate model of the crystal.

![Figure B.11 – Face (1 3 -2) is incorrect](image)

1. In the Face List, select the HKL (1 3 -2).
2. Right-click and select Remove. The face is removed from the list and the model is improved (Figures B.13 and B.13).

**NOTE:** Alternatively, you can select Clear List to start over, or Add and Edit to define your own faces and see where they appear on the crystal.

![Figure B.12 – Face List right-click menu](image)

![Figure B.13 – Face (1 3 -2) removed](image)
B.4 Scaling With Face Indices

1. When all faces are defined, APEX2 has accurate crystal dimensions (as shown in the bottom right-hand corner). At this point, you can exit the Face Indexing module and proceed with scaling.

2. In the Scaling module, be sure to select **Numerical Absorption Correction (From Face Indices)** under the Setup tab (see Section 7.3.1).
Appendix C  Using CELL_NOW

CELL_NOW is an extremely powerful tool for determining unit cells for difficult crystals. It analyzes a list of reflections to find a cell and orientation matrix despite the presence of several twin domains or other problems.

In initial search mode, the program tries to find sets of reciprocal lattice planes that pass close to as many reflections as possible. The corresponding real space vectors are sorted on a figure of merit (1.0 being a perfect fit). After the vector list has been output, CELL_NOW attempts to suggest a suitable cell. This will not necessarily be the conventional cell, so it should be checked using XPREP.

Once a cell is found, it may be rotated to locate further twin domains iteratively using only the reflections that have not yet been indexed.

If CELL_NOW fails to suggest a sensible cell, either something is seriously wrong with the reflection list (e.g., a wrong detector distance) or a cell axis is longer than the given search range.

C.1  Running CELL_NOW

CELL_NOW must be run from the command line. It requires a list of reflections exported from the APEX software (a .p4p file).

1. Open a Command Prompt window.
2. Change directories to the folder containing the exported reflection list.
3. For Windows or Linux, enter the command: cell_now

After the command is entered, the terminal will print out an explanation of the program. Read this as it has useful information about what the program is doing:
CELL_NOW analyses a list of reflections to find a cell and orientation matrix despite the presence of several twin domains or other junk. In initial search mode the program tries to find sets of reciprocal lattice planes that pass close to as many reflections as possible. The corresponding real space vectors are sorted on a figure of merit (1.0 would be a perfect fit). In the output these are followed by the percentages of reflections that fit within 0.1, 0.2 and 0.3 times the interplanar separation, the components a1, a2 and a3 of the vector, the angles to previous vectors and a cross figure of merit to previous vectors. The latter should be larger for reflections belonging to the same twin component. Cosines of angles between vectors a and b can also be calculated from the components by \((a1*b1+a2*b2+a3*b3)/(a*b)\).

After the vector list has been output, CELL_NOW attempts to suggest a suitable cell. This will not necessarily be the conventional cell, so it should be checked using XPREP (without an .hkl file) taking the lattice type found with CELL_NOW into account. If necessary this conventional cell may be reinput in 'specified cell' search mode to find the orientation matrix. If CELL_NOW fails to suggest a sensible cell, either something is seriously wrong with the reflection list (e.g. a wrong detector distance) or a cell axis is longer than the given search range.

In specified cell search mode the program tries to find the best cell within the specified ranges. The reflections that fit this cell within a specified fraction of all three interplanar spacings may be flagged as indexed, and a new .p4p or .spin file written in which they have the 'H' flag so that they can be displayed in a different color with RLATT. Then the cell may be rotated to locate further twin domains iteratively using only the reflections that have not yet been indexed.

** WARNING: the exhaustive search employed in this program is VERY SLOW **
** so a CPU clock frequency of AT LEAST 3GHz is strongly recommended **
4. **CELL_NOW** requests the name of the input file and suggests a name for the output file. Enter the name of the input file (For the output file, press [Enter] to accept the default).

   Full name of .p4p, .spin or .drx file to read: **example.p4p**

   999 reflections read in

   Listing file [example._cn]:

   514 reflections read in

   Listing file [example._cn]:

5. Press [Enter] to start a general search.

   Initial search (<Enter>) or specified cell search (S):

6. If the default superlattice threshold is suitable, press [Enter].

   Superlattice threshold: an axis will be rejected if less than this percentage of reflections has indices not equal to 2n or 3n resp. [10]:

7. If the default minimum and maximum distances are acceptable, press [Enter] again.

   Minimum and maximum allowed values for cell edge [5 40]:

---

**NOTE**: Usually **CELL_NOW** is used to search generally for a cell, but if the cell is known, choose the specified cell option and enter the cell dimensions. **CELL_NOW** will then search for a matching cell.

After some period of time, a list of real space vectors sorted on a figure of merit (1.0 being a perfect fit) will be output. These are followed by the percentages of reflections that fit within 0.1, 0.2 and 0.3 times the interplanar separation, the components a1, a2 and a3 of the vector, the angles to previous vectors and a cross figure of merit to previous vectors. The latter should be larger for reflections belonging to the same twin component. Cosines of angles between vectors a and b can also be calculated from the components by \((a_1^*b_1+a_2^*b_2+a_3^*b_3)/(a^*b)\).
<table>
<thead>
<tr>
<th>Length</th>
<th>fom</th>
<th>#hits</th>
<th>%(0.1)</th>
<th>%(0.2)</th>
<th>%(0.3)</th>
<th>components</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.692</td>
<td>0.902</td>
<td>30</td>
<td>94.493</td>
<td>99.999</td>
<td>99.999</td>
<td>-0.475</td>
</tr>
<tr>
<td>11.016</td>
<td>0.891</td>
<td>20</td>
<td>99.098</td>
<td>99.698</td>
<td>99.899</td>
<td>0.491</td>
</tr>
<tr>
<td>16.802</td>
<td>0.836</td>
<td>24</td>
<td>93.793</td>
<td>99.398</td>
<td>99.698</td>
<td>-0.011</td>
</tr>
<tr>
<td>139.0</td>
<td>131.0</td>
<td>19</td>
<td>80.379</td>
<td>93.692</td>
<td>98.898</td>
<td>-0.446</td>
</tr>
<tr>
<td>27.701</td>
<td>0.736</td>
<td>43</td>
<td>78.477</td>
<td>92.091</td>
<td>97.296</td>
<td>1.396</td>
</tr>
<tr>
<td>27.428</td>
<td>0.722</td>
<td>45</td>
<td>77.376</td>
<td>98.497</td>
<td>99.598</td>
<td>-0.496</td>
</tr>
<tr>
<td>18.381</td>
<td>0.688</td>
<td>35</td>
<td>72.271</td>
<td>86.285</td>
<td>91.791</td>
<td>-15.128</td>
</tr>
<tr>
<td>6.329</td>
<td>0.686</td>
<td>4</td>
<td>65.465</td>
<td>65.465</td>
<td>65.465</td>
<td>0.248</td>
</tr>
<tr>
<td>14.648</td>
<td>0.684</td>
<td>18</td>
<td>73.873</td>
<td>85.484</td>
<td>91.090</td>
<td>-14.633</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Followed by angle/correlation to previous vectors:

| 90.0  | 0.798 |
| 139.0 | 0.754 |
| 16.805| 0.819 |
| 139.1 | 0.749 |
| 27.693| 0.741 |
| 23.4  | 0.675 |
| 27.701| 0.687 |
| 25.428| 0.651 |
| 18.381| 0.650 |
| 14.648| 0.596 |
|        |      |       |        |        |        | -11.432    |
| 11.016| 0.891 |
| 16.802| 0.836 |
| 90.0  | 0.798 |
| 139.0 | 0.754 |
| 16.805| 0.819 |
| 139.1 | 0.749 |
| 27.693| 0.741 |
| 23.4  | 0.675 |
| 27.701| 0.687 |
| 25.428| 0.651 |
| 18.381| 0.650 |
| 14.648| 0.596 |

| 119.9 | 150.1 |
| 17.5  | 133.2 |
| 119.9 | 150.1 |
| 19.1  | 101.0 |
| 0.651 | 0.674 |
| 18.381| 0.688 |
| 89.3  | 127.1 |
| 18.381| 0.688 |
| 14.648| 0.684 |
| 14.648| 0.684 |
|        |      |       |        |        |        |            |

| 0.596 | 0.650 |
| 0.596 | 0.650 |
| 0.596 | 0.650 |
| 0.596 | 0.650 |
| 0.596 | 0.650 |
|        |      |       |        |        |        |            |

| 0.591 | 0.603 |
| 0.591 | 0.603 |
| 0.591 | 0.603 |
| 0.591 | 0.603 |
| 0.591 | 0.603 |
|        |      |       |        |        |        |            |
After the vector list has been output, CELL_NOW attempts to suggest a suitable cell. This will not necessarily be the conventional cell, so it should be checked using XPREP (without an .hkl file) taking the lattice type found with CELL_NOW into account. If necessary, this conventional cell may then be input in 'specified cell' search mode to find the orientation matrix.

The following cells would appear to be plausible, but should be checked using XPREP because they are not necessarily the conventional cells.

FOM, % within 0.2, a..gamma, volume and lattice type for potential unit-cells:

<p>| | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.000</td>
<td>85.3</td>
<td>12.692</td>
<td>11.016</td>
<td>14.648</td>
<td>89.70</td>
<td>90.95</td>
<td>90.00</td>
<td>2047.7</td>
<td>P</td>
<td></td>
</tr>
</tbody>
</table>

Cell for domain 1: 12.692 11.016 14.648 89.70 90.95 90.00

Figure of merit: 0.619  %(0.1): 68.3  %(0.2): 85.3  %(0.3): 91.0

CELL_NOW has identified a domain that fits 85.3% of the data with a tolerance of 0.2.
The output shows a suitable cell with its orientation matrix, figure of merit and the deviations of the input reflections from integer indices. This deviation is used to determine which reflections fit this cell and which are left for further searches for new domains.

Orientation matrix:

\[
\begin{bmatrix}
0.00164338 & -0.00357404 & -0.06816319 \\
-0.03417112 & 0.08170117 & -0.00385047 \\
0.07098872 & 0.03940338 & 0.00098036
\end{bmatrix}
\]

Maximum deviation from integer index [0.25]:

8. Enter the maximum deviation from integer index cutoff (Typically the default is reasonable). Press [Enter].

Percentages of reflections in this domain not consistent with lattice types:

A: 50.1, B: 49.9, C: 45.0, I: 48.9, F: 72.5, O: 64.3 and R: 65.8%

Lattice information (given as % of relevant reflections that do not fit a particular lattice) should be used in XPREP to determine the conventional cell. Typically, for a lattice to be present the % inconsistent should be less than 10, but problem crystals can make the value higher.

Percentages of reflections in this domain that do not have:

h=2n: 36.3, k=2n: 49.8, l=2n: 49.3, h=3n: 69.1, k=3n: 67.2, l=3n: 66.4%

This percentage information is useful for identifying supercell problems. Typically, the percentages should be 30% or higher for the 2n values and 50% or higher for the 3n values, but problem crystals or crystals with heavy atoms in special positions can make the values lower. Low values for a particular class of reflections can suggest that an axis is double (2n) or triple (3n) its correct length.

New cell from list (number), reorientate (R), accept (A) or quit (Q) [A]: A
9. Enter A or just press [Enter] to accept this cell. The program asks for a name for a .p4p file. Enter the name of the .p4p file for this solution (in this example, domain1.p4p).

.p4p or .spin file to write domain to: domain1.p4p

RLATT color-coding employed in file: domain1.p4p
White: indexed for first domain
Red: not yet indexed

877 reflections within 0.250 of an integer index assigned to domain 1, 877 of them exclusively; 122 reflections not yet assigned to a domain

122 reflections, approximately 1/10 of the data, have not yet been indexed (assigned to a domain). This is more than might be expected for random noise peaks. A search for an additional domain makes sense. The domain 1 cell will be rotated to locate further twin domains iteratively using only the reflections that have not yet been indexed.

Re-refine initial cell (R), search for next domain (S), quit (Q) or choose new cell from list (enter number) [S]: S

10. Enter S to search for another orientation of the newly chosen cell.

Cell for domain 2:  12.692  11.016  14.648  89.70  90.95  90.00
Figure of merit: 0.643  %0.1: 69.7  %0.2: 97.5  %0.3: 98.4
Orientation matrix:  0.00598966  0.00402327  0.06807401
-0.03367313 -0.08180340  0.00480114
0.07099302 -0.03914713 -0.00221035

Rotated from first domain by 179.7 degrees about reciprocal axis  1.000  0.001 -0.032 and real axis  1.000  0.002 -0.010

Twin law to convert hkl from first to this domain (SHELXL TWIN matrix):  0.999  0.004 -0.019
0.003 -1.000 -0.004
-0.064  0.006 -0.999
CELL_NOW has identified an additional domain that fits 97.5% of the data with a tolerance of 0.2. The relationship between this domain and the first domain and the SHELXL TWIN matrix are reported. This example is for a rotational twin about the a* axis.

The output shows a suitable cell with its orientation matrix, figure of merit and the deviations of the input reflections from integer indices. This deviation is used to determine which reflections fit this cell and which are left for further searches for new domains.

11. Enter the maximum deviation from integer index cutoff (typically the default is reasonable).

Maximum deviation from integer index [0.25]:

12. Enter the name of the .p4p file for this solution (in this example domain2.p4p).

.p4p or .spin file to write domain to: domain2.p4p

RLATT color-coding employed in file: domain2.p4p
White: indexed for first domain
Green: current domain (but not in a previous domain)
Red: not yet indexed

691 reflections within 0.250 of an integer index assigned to domain 2,
119 of them exclusively; 3 reflections not yet assigned to a domain

Re-refine initial cell (R), search for next domain (S), quit (Q) or choose new cell from list (enter number) [Q]

13. Enter <q> to exit CELL_NOW.

C:\struc\guest\twin>

NOTE: At this point CELL_NOW has indexed a two-component twin. The orientation matrices for the two components are in the domain2.p4p file discussed below.
C.2 CELL_NOW output

In this example, in addition to the terminal output described above and the example .cn listing file written to disk, CELL_NOW has written two .p4p files, domain1.p4p and domain2.p4p. The second of these is a multicomponent .p4p for a two-component twin. It is shown below.

The following entries appear twice: once for each domain.

CELL, ORT1, ORT2, ORT3, ZEROES, ADCOR
CELL2, ORT12, ORT22, ORT32, ZEROES2, ADCOR2

This will eventually trigger SAINT to treat this data set as a twin.

FILEID SAINT V6.43A 4.00 06/19/03 09:36:24 mraa
SITEID RufM Ruf
TITLE [RCpCrCl2.nTHF]n
CHEM C40H58Cr2Cl4O2
CELL 12.6918 11.0161 14.6480 89.7011 90.9494 90.0010 2047.695
CELLSD 0.0025 0.0022 0.0029 0.0300 0.0300 0.0300 1.024
ORT1 0.001643376 -0.003574040 -0.068163186
ORT2 -0.034171116 0.081701167 -0.003850471
ORT3 0.070988722 0.039403379 0.000980361
ZEROS 0.0000000 0.3249754 -0.0041494 0.0000 0.0000 0.0000
ADCOR 2.9302 -0.0047 0.0003 -0.8959 0.0123 0.0937
CELL2 12.6918 11.0161 14.6480 89.7011 90.9494 90.0010 2047.695
CELLSD2 0.0025 0.0022 0.0029 0.0300 0.0300 0.0300 1.024
ORT12 0.005989663 0.004023272 0.068074010
ORT22 -0.033673126 -0.081803404 0.004801138
ORT32 0.070993021 -0.039147127 -0.002210349
ZEROS2 0.0000000 0.3249754 -0.0041494 0.0000 0.0000 0.0000
ADCOR2 2.9302 -0.0047 0.0003 -0.8959 0.0123 0.0937
SOURCE Mo 0.71073 0.70930 0.71359 2.00000 50.00 40.0
NOTE: SAINT+ users should be aware that APEX2 Version 2 can import .p4p files created with CELL_NOW and the Integrate Images module will handle the multiple orientation matrices correctly. There is no longer a need to use the standalone SAINT+ program.
Appendix D Configuring APEX2

The APEX2 Suite includes the ability to customize many features of the program. Most customizations should be left to the site administrator, but some introduction is appropriate. The example below is a color-coded example of an actual Python file. It gives an introduction to configuring the program.

The following is a collection of examples of possible changes to the configuration files for APEX2 and PROTEUM2. These files control the look and feel of the GUI.

D.1 Global, User, and Sample-specific Variables

Configuration variables the system administrator wants to set globally for all users go into a file called `bn-config.py` that resides in C: for Windows or /usr/local/lib for Linux. Individual users can set their own preferences for most configuration variables in a file in their home directory. This file is named `bn-config.py` for Windows and `.bn-config` for Linux (Under Windows, at a command prompt type `echo %UserProfile%` to find out where the user version of `bn-config.py` should be located.) Additionally, configuration variables can be set for a specific sample using a file in the sample directory. This file is `bn-config` for Windows and Linux. These files are read in the order given above, so values set globally are replaced by individual values and global and individual values are replaced by sample-specific values.

D.2 Python Code Examples

In the following text,

- Red denotes comments that result from `#` comments.
- Green denotes comments between triple quotes (""").
- Black denotes actual Python code.

```python
# Examples of configuration changes-
```
A few notes about Python comments.
Three quotation marks in a row on a line (""") start a comment section
The next three quotation marks (""") end the section
The text you have just read is in a comment section
***
#end of commenting out a section with triple """"s
# Pound or Number starts a simple comment. This can be anywhere on a line.
#
#
# The default color scheme for the image display:
#
## colorramp='Colored_SCD.ICM'    # This is the typical BAXS orange display
##
###
The most frequently used other color choices are:

Black_On_White_SCD.ICM
White_On_Black_SCD.ICM
The_Blues_ANY.ICM

Other color ramps are in:

Windows: C:\bn\src\gui\intensitycolormaps
Linux:   /usr/local/bn/src/gui/intensitycolormaps
###
#
# This is how user positions can be defined:
#
userpos1=
    {'name': 'Zero@dx60', 'type': 'n',
     'dx': 60.0,
     'theta': 0,
     'omega': 0,
     'chi': 0,


'phi': +0.0 }
#
# If you want angles other than zero, the import projtls and del projtls must be used:
#
import projtls
userpos2=
  {'name':'Chi45@dx90','type': 'n',
   'dx': 90.0,
   'theta': -10.0*projtls.degrees,
   'omega': -5.0*projtls.degrees,
   'chi': 45.0*projtls.degrees,
   'phi': 180.0*projtls.degrees }

del projtls
#
# Acceptable CCD temperature:
#
ccdtemperaturerange=(-65,-55)
#
# Auto connect to the instrument when needed:
#   (This is a protected variable that is controlled by the System Administrator)
#
autoconnect=1
#
# The following five values define matrix runs:
#
perpendicular_matrix_runs_2theta=30
# Set the 2-theta for the matrix measurement:
perpendicular_matrix_runs_distance=41
# Set the detector distance for the matrix measurement:
perpendicular_matrix_runs_nr_sweeps=3
# Do three sweeps or runs:
perpendicular_matrix_runs_sweep=6
# Each run will be 6 degrees long.
perpendicular_matrix_runs_frametime=None
# The frame time is left to be the default.
#
# Setup to get some debug messages for scans. This is useful if resume is failing.
#
#debug=('goniometer.scan',)
#debug=('expt.findresolution',)
#
# Hardware profile used by the data collection strategy planner:
bishost='bruker-server'
hardwareprofile='Kappa-APEX-II-euler.hrd'
#bishost='smart-apex'
#hardwareprofile='SMART-APEX-II.hrd'
#
# IP address or DNS name of the file server used for storing images, followed by the name of a network shared folder on that server. Add additional path segments as comma-separated and quoted strings. To find out the DNS name:
# For Linux type: hostname at the command prompt
# For Windows type: echo %computername% at the DOS prompt.
#
#fileserves='x8-client','frames')

# Supported file name protocols. Currently these are 'smb' for files that are accessed over a MS Windows network and 'file' for local files.
universalfnprotocols=('smb','file')
#


Configuration of the APEX & PROTEUM programs
============================================

The appearance and working of this suite of programs can be modified by a configuration file. The programs read a series of configuration files in following order. As described below, a specification in a later file overwrites a setting in an earlier file.

On unix these files are:
1 a file /usr/local/lib/bn-config.py
2 a file .bn-config in your home directory (Please note the initial "." character, which renders this file invisible for the normal "ls" command).
3 a file bn-config in your current directory.

On Windows these files are:
1 bn-config.py in the "SystemDrive" folder
2 bn-config.py in the "USERPROFILE" folder
3 bn-config in the current folder

If none of these files is present (the situation when the program has just been installed) all parameters are using built-in defaults. To change a single configuration parameter, creates or edits one of the three files and put in a value for the parameter to be customized.

You should put a parameter in (1) if it should be the system default for all users; put it in (2) if it is your own default, and other people might want to use other values; put it in (3) if it is only required for a single project.

The configuration files are read as "Python" programs, and therefore syntax is very important. The best way to use it is to only use variable assignments or function calls, as described below. If required, you can comment out lines from your configuration file by preceding them with a ‘#’ character.
Note:

- Leading space is significant. Start all assignments in the first column.
- Variable names are case sensitive.

Functionality groups

Sometimes a complete group of options need to be changed to get a specific functionality. For these cases there are function calls that change a number of variables at once.

Due to the "default-like" nature of these function calls, they should probably be used only in the site-wide configuration files, and even there only at the beginning [but this is not enforced].

The available functions are:

default_protein()
This switches from the default "small molecule" parameters to more protein-like parameters. At this time, the following parameters are set:
  - chiralonly=1
  - autochiralpointgroup=1
  - resomode=1
  - resolution=2.5

default_noprotein()
This sets the defaults back to small molecule values

The following variables, in alphabetic order, can be set in a configuration file.

* anglemargin, type=float, default=1.0
  Do not change

* autochiralpointgroup, type=boolean, default=0
  This selects whether point groups are preferably chiral. This can be useful in a protein setting.
* autoconnect, type=boolean, default=0
  If this is set to 1, the connection to the BIS server will be created automatically without user-intervention whenever required. This variable can only be changed in the system-wide configuration file (see "protectedvariables")

* axcrit, type=float, default=0.2 degrees
  This is the criterion used by the automatic cell reduction algorithm to decide whether two axes coincide. Do not touch.

* badcolor, type=tuple of three integers, default=(255,190,190)
  Color in the GUI that is associated with 'bad' situations

* busycolor, type=tuple of three integers, default=(240,240,96)
  Color in the GUI that is associated with 'busy' situations

* bgdone, type=tuple of three integers, default=(96,240,96)
  Color in the GUI that is associated with 'done' situations

* bgerror, type=tuple of three integers, default=(240,96,96)
  Color in the GUI that is associated with 'error' situations

* bgimpossible, type=tuple of three integers, default=(240,240,96)
  Color in the GUI that is associated with 'impossible' situations

* bgpossible, type=tuple of three integers, default=(96,240,96)
  Color in the GUI that is associated with 'possible' situations

* bgtodo, type=tuple of three integers, default=(96,240,96)
  Color in the GUI that is associated with 'todo' situations

* bgwarning, type=tuple of three integers, default=(240,240,96)
  Color in the GUI that is associated with 'warning' situations

* bishost, type=string, default is not set
  The name or IP address of the BIS server computer
* ccdtemperaturerange, type=tuple of 2 integers, default=(-65,-35)
  Acceptable range (minimal,maximal) of temperatures in deg C for the detector.
  This is used only to indicate a red or a green status light for the CCD
temperature in the status window.

* chiralonly, type=boolean, default=0
  If set to 1, only chiral point groups will be used at any moment. Do not touch.

* colorramp, type=file name, default='Colored_SCD.ICM'
  Default color ramp used by the image display tool

* communicationlog, type=file name, default='communication.log'
  File name used for logging all communication between application and BIS. If not
  set, no logfile will be kept.

* component1color, type=string (color name), default='green'
  The component#color variables are obsolete. Use groupcolors instead.

* component2color, type=string (color name), default='blue'
  The component#color variables are obsolete. Use groupcolors instead.

* component3color, type=string (color name), default='yellow'
  The component#color variables are obsolete. Use groupcolors instead.

* datcoldx, type=float, default=35.0
  Default sample-to-detector distance for data collections.

* dbtype, type=string, default='postgresql'
  Type of database engine used. Do not touch.

* dbhost, type=string, default='127.0.0.1'
  Name or IP address of the server running the database. The default is to
  run the database on the same host as the rest of the software, hence the
default that refers to the local host.
* dbport, type=string, default='5432'
  IP port to use to address the database. Normally dependent on database
  installation.

* dbname, type=string, default='BAXSdb'
  Name of the database. Do not touch.

* debug, type=tuple of strings, default=()
  This is a list of all modules that are to be debugged. This should
  not be touched except if a developer asks you to add something here to
  help track a problem.

* defaulthardwaretype, type=integer, default=4
  If different hardware types are supported, this can be used to select which one
  should be used. 4=BIS. Do not touch.

* detectorfizemargin, type=floating point, default=0.1
  Do not touch.

* eventlogfile, type=file name, default='bn-event.log'
  File in which important events are logged during program runs.

* fontsize, type=integer, default=None
  GUI font size in points

* groupcolors, type=tuple of color names, default=('gray75',
  'red','green','yellow','blue','magenta','cyan','white',
  'gray25','brown','forest green',
  'khaki','midnight blue','violet','turquoise','gray50')

* guicolor, type=tuple of three integers making a color, default=0xd4,0xd0,0xc8
  Overall background color of user interface.

* guistyle, type=string, default='windows'
  The style of the GUI. Do not touch.
* **hardwareprofile**, type=file name, default=None
  The hardware profile to be used by COSMO for strategy calculations.

* **hashfilepattern**, type=string, default='_##_####'
  Do not touch

* **headerdisplay**, type=?, default=not set
  If present, this variable defines the name of a file containing the default image header items that should be displayed in the table underneath the image display.

* **imageextension**, type=string, default='.sfrm'
  Do not touch

* **imagemask**, type=int, default=0
  Value of a mask used in viewing powder frames

* **inhibitgc**, type=boolean, default=0
  Inhibit garbage collection. Do not touch.

* **localfilemap**, type=map, default=None
  A map of network drives, translating local file names to equivalent network names. On Windows machines, this is set automatically. On unix, this should represent a copy of the relevant parts of the samba configuration.

* **lowcurrent**, type=floating point, default=5
  Tube current in mA to set when an experiment finishes.

* **lowvoltage**, type=floating point, default=20
  Tube voltage in kV to set when an experiment finishes.

* **mailfrom**, type=string, default=Not set
  The "From" address of E-mails sent by the software (e.g. bug reports).

* **mailfromdomain**, type=string, default=Not set
  The domain of the From address of E-mails sent by the software. This will only be used if "mailfrom" is not set. The user name will be pre-pended.
* matrixstrategy, type=list of scans, default=3 specific scans
  The measurement strategy that is to be used to find a unit cell.

* minimalpowerfraction, type=floating point, default=0.5
  The minimal generator power as fraction of the maximal power that will be
  considered as sufficient to make a measurement

* mosaicty, type=floating point angle, default=0.4
  Expected normal width of a reflection, in degrees.

* nominalpowerfraction, type=floating point, default=0.9
  The normal generator power as fraction of the maximal power that the generator
  should be set to before a measurement

* nominalvoltage, type=map, default={'MO':60,'CU':45,'AG':60}
  A definition of the nominal tube voltage in kV as a function of the
  target element.

* orientdx, type=floating point, default=-5
  The default crystal to detector distance for the “aligned images” module. If
  given as a negative number, it is counted from the back of the dx-sled.

* orientdegreetime, type=floating point, default=10.0
  Default scan time in seconds per degree for an aligned image.

* orientscanwidth, type=floating point, default=5.0
  Default scan angle in degrees for an aligned image.

* overlapcolor, type=color string, default='red'
  Color used for overlapping predicted spots

* overlaycolor, type=color string, default='green'
  Color used for predicted spots

* peakradiusfactor, type=floating point, default=2.2
  How many times the single-sigma-spot radius should be used as integration radius.
  Do not touch.
* planes, type=string, default='0kl h0l hk0'
   List of precession planes that is suggested as default planes for the
   calculations

* planethickness, type=floating point, default=0.1
   Default thickness of precession images

* precessionmargin, type=integer, default=1
   How many pixels at the outer edge of the detector that is to be ignored in
   precession calculations

* prefereulerian, type=boolean, default=1
   1 = prefer eulerian geometry over kappa geometry
   0 = prefer kappa geometry over eulerian geometry
   This should not be changed after installation.

* preferreddirection, type=integer, default=-1
   (default rotation direction of axes)

* productline, type=string, default='ANY'
   A selection of the features in the program suite based on the type of
   application we’re running:
   ‘ANY’ or ‘ALL’ = all products,
   ‘SCD’ = single crystal,
   ‘XRD’ = powder,
   ‘XRF’ = fluorescence

* protectedvariables, type=map, default={'protectedvariables':1,'autoconnect':1}
   A selection of variable names and a limit to which configuration files can be
   used to change them. This can be used to make sure users do not overwrite system
   defaults, like is done by default for the autoconnect variable.

* resolution, type=floating point, default=0.77
   Default resolution to go for in an experiment. 0.77 is reasonable for standard
   small-molecule experiments.
* **scanrepr**, type=integer, default=-1
  Determines how scans are represented in text:
  -1: scan angle from x to y length y-x
  0: scan angle length y-x starting from x
  1: scan angle from x to y

* **scanwidthtolerance**, type=float, default=0.003
  Tolerance in degrees that determines whether two scans are equal. Do not touch.

* **fileserver**, type=tuple of strings, default=()
  Where experiment data files should be stored by default. First element in the
tuple is the host name, second the share name, and the rest are successive
folder names inside the share.

* **fileserverprotocol**, type=string, default='smb'
  The protocol that should be used to address the file server. Should be either
  'file' (local file) or 'smb' (network drive)

* **smbroot**, type=string, default='/smb'
  Unix only. Where samba will mount shares made available from other hosts.

* **smtphost**, type=string, default='localhost'
  Host of a machine that can be addressed via SMTP to send E-mails.

* **statuslines**, type=integer, default=1000
  Maximum number of lines displayed in status window

* **temperaturerampspeed**, type=integer, default=240
  The speed to use for ramping the temperature of a low-temperature device, in K
  per hour.

* **universalfnprotocols**, type=tuple of strings, default=('smb','file')
  Allowed protocols to exchange files with the BIS. Should be
  ('smb','file') when BIS is running on the same machine, and ('smb',)
  if BIS is running remotely.
* userpos1, type=scan, default=Not set
  User-defined instrument axis position. See the example on page D-2.

* userpos2, type=scan, default=Not set
  User-defined instrument axis position. See the example on page D-2.

* userpos3, type=scan, default=Not set
  User-defined instrument axis position. See the example on page D-2.

* userpos4, type=scan, default=Not set
  User-defined instrument axis position. See the example on page D-2.

* calibweaklevel, type=integer, default=10
  Minimal I/sigma for peaks to be used in calibration routines.
Index

A
About box 3-10
Absorption correction and Face Indexing in Scale module 7-14
Access levels 4-2
Accounts 4-2
Acentric space groups and Intensity Statistics 7-18
ACTA output 9-23
Active Mask and Spatial Distribution plots 7-20
Align Crystal 3-3
Anisotropic refinement 9-14
APEX II detector 2-3
APEX2 modules overview 3-5
required rights 4-2
shutting down 4-6
starting 4-3
APEX2Server 3-3, 5-1, 5-18
Append Strategy 6-23
Archive function 3-9, 3-11

Atom labelling
in XShell 9-10
Atomic Displacement Parameters 9-16
Attenuator (SMART APEX II) 2-7
Audit trails 3-6
Automatic connection to BIS 4-4
Automatic unit cell determination 6-6
AutoStructure 1-1, 3-13
Average Difference 7-9
AXScale closing 7-21

B
Bad runs 7-16
Base Name 6-8
BCP 3-5
required rights 4-2
Beamstop 2-7
BIS 2-1, 3-4, 4-2
description 4-3
shutting down 4-6
starting 4-3
bn-config.py  4-4, D-1
bn-license.dat  4-5
Bravais lattice  6-12, 6-13
  figure of merit  6-13
Bruker AXS Service Centers  1-5
BrukerInstrument.ini  3-5

Computer
  single-computer configuration  2-8
Connection... dialog  3-10, 4-4
Copy RES to INS  9-6
Correlated frames  6-8
Coverage Statistics  7-11, 7-12
Crystal centering  5-1
Crystal Faces  B-1
Crystal quality
  screening images  5-22

C
Calibration module  3-14
Cautions  1-3
  defined  1-3
CELL_NOW  C-1
Center Crystal module  3-12
Centric space groups
  and Intensity Statistics  7-18
Centroids  A-9
Chiral compounds
  specifying in XPREP  8-3
Chi-Squared plots  7-18
CIF file  9-23
Client
  additional computers  2-8
  defined  3-1
Client and Server Functions  3-1
Closing Sample alert window  4-6
Collect data
  collecting a data set  6-23
  when finding unit cell  6-8
Collimator  2-3, 2-7
Compare Unit Cells  3-13
Completeness
  in Strategy module  6-18
  in XPREP  8-4

D
D8 Controller  2-8
D8 family of instruments for XRD  2-1
Data Collection Strategy module
  overview  6-16
Deleting samples from database  3-11
Describe module  3-12, 6-2
Determine Unit Cell module  3-12, 6-4
Diagnostics
  messages in BIS  3-4
  plots in Scale module  7-17
Diamond-anvil cells  2-9
Difference electron density maps  9-22
Difference peaks  9-15
  removing  9-16
Direct methods  9-3
Distance
  optimum detector distance  6-16
Domains
  in CELL_NOW  C-1
Dovetail track (SMART APEX II)  2-3
Drive + Scan  5-19
<table>
<thead>
<tr>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dual Space Methods</td>
<td>DX track</td>
<td>9-4 opening</td>
</tr>
<tr>
<td>DX track</td>
<td>2-3, 2-4</td>
<td>3-11</td>
</tr>
<tr>
<td>EI button in XShell</td>
<td>9-11</td>
<td>Generate New Darks</td>
</tr>
<tr>
<td>Enclosure</td>
<td>2-1, 2-8</td>
<td>Generate Report module</td>
</tr>
<tr>
<td>opening doors</td>
<td>5-2</td>
<td>Generator</td>
</tr>
<tr>
<td>Error Model</td>
<td>7-16</td>
<td>automatic ramping</td>
</tr>
<tr>
<td>Ethylene glycol (for recirculator)</td>
<td>2-8</td>
<td>K780 description</td>
</tr>
<tr>
<td>Ewald sphere</td>
<td>6-15</td>
<td>Generators</td>
</tr>
<tr>
<td>in refinement</td>
<td></td>
<td>K780 overview</td>
</tr>
<tr>
<td>Excluded shells</td>
<td>6-10</td>
<td>Geometrically strained carbon atoms</td>
</tr>
<tr>
<td>Execute</td>
<td>6-24</td>
<td>Goniometer Head</td>
</tr>
<tr>
<td>Exit</td>
<td>3-9</td>
<td>adjustment sleds</td>
</tr>
<tr>
<td>Exiting APEX2 after starting an experiment</td>
<td>6-1, 6-24</td>
<td>Goniometers</td>
</tr>
<tr>
<td>EXP files</td>
<td>6-23</td>
<td>1-1, 2-3</td>
</tr>
<tr>
<td>Experiment module</td>
<td>3-12</td>
<td>Greek and Roman Text</td>
</tr>
<tr>
<td>loading and saving experiments</td>
<td>6-23</td>
<td>Groups</td>
</tr>
<tr>
<td>overview</td>
<td>6-23</td>
<td>in RLATT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GUI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>overview</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3-7</td>
</tr>
<tr>
<td>F</td>
<td>H</td>
<td></td>
</tr>
<tr>
<td>Face Indexing</td>
<td>2-7, 3-13</td>
<td>Harvest Spots</td>
</tr>
<tr>
<td>Face List</td>
<td>B-3</td>
<td>6-9</td>
</tr>
<tr>
<td>Face normals</td>
<td>B-4</td>
<td>Help</td>
</tr>
<tr>
<td>Find a Reflection</td>
<td>3-13</td>
<td>1-4</td>
</tr>
<tr>
<td>Fixed-chi</td>
<td>2-5</td>
<td>Histograms</td>
</tr>
<tr>
<td>Formula</td>
<td>9-2</td>
<td>in Scale module</td>
</tr>
<tr>
<td></td>
<td>6-3</td>
<td>in unit cell refinement</td>
</tr>
<tr>
<td></td>
<td>8-5</td>
<td>Huber goniometer head</td>
</tr>
<tr>
<td>Frames</td>
<td></td>
<td>Hybridize All command</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hydrogen atoms</td>
</tr>
<tr>
<td></td>
<td></td>
<td>adding in XShell</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9-20</td>
</tr>
</tbody>
</table>
Index

I
I/sigma(I) in unit cell determination 6-9, 6-11
Image width 6-8
Index 6-11
Information on All Atoms 9-8, 9-16
Integrate Images module 3-12
Integrated intensities 7-1
Integration Progress display 7-9
Intensity Statistics 7-18
Interlocks 2-8
Isolated reflections 6-11
Isotropic displacement parameters 9-16

Logout 3-9

M
Manual unit cell determination 6-7
Mean Weight 7-15
Menu Bar 3-7
Merge all equivalents in XPREP 8-4
Monochromator 2-3, 2-6
Mosaicity 6-4
Mount position 5-3
Movie view for frames 3-11

N
New Sample 3-11, 6-2
No active sample 3-12
Noise peaks removing in XShell 9-9
Nonius goniometer head 5-5
Normals in Face Indexing B-4
Notes 1-3
defined 1-3
Numerical Absorption Correction (From Face Indices) B-8

O
Omega free rotation 2-4, 2-5
Online and Offline Operation 4-2
Open in XP 9-6

Index - 4
# APEX2 User Manual

## Index

### P

- Open in XShell: 9-6
- Open sample: 3-11
- OpenGL rendering alert: 9-26
- Oriented Scans module: 3-12

### P4P files

- CELL_NOW output: C-8
- importing and exporting: 3-9
- writing from RLATT: A-22

### Patterson Methods

- 9-4

### Peltier devices

- 2-8

### Phase ID

- 1-1, 3-13

### Pink fields (invalid entries)

- 3-8

### Planarity

- and mpla cards: 9-24

### Plotting lines

- drawing: 3-11

### Power settings

- recommended maximum: 2-6

### Precession Images

- 3-13, 8-7

### Publication

- Generate ACTA(CIF) Information File: 9-23
- refinement in XShell: 9-23

### Python

- D-1

### R

- R(int)
  - variations: 7-17
  - vs. resolution: 7-18
- R1 value: 9-14, 9-15, 9-22
- Reciprocal Lattice Viewer: 3-12, A-1
- Recirculator (for detector): 2-8
- Redundancy
  - in XPREP: 8-4
- Referenced Documentation: 1-3
- Refine
  - in Scale module
  - when determining unit cell
  - with XL: 9-6
- Reflection Group Combo Box: 6-10
- Reflection Statistics: 8-4
- Relabel peaks: 9-11
- Resolution circle
  - drawing: 3-11
- Restore
  - archived samples: 3-11
- Rint: 8-4
- RLATT
  - measuring distances and angles in
  - overview: A-20
- RMS XY: 6-15
- Rsigma: 8-4
- Rsym
  - overall: 7-11, 7-12
- R-values
  - 7-15, 7-16
S
SADABS 3-1
Safety issues 1-4
SAINT 3-1
SaintChart 7-8
SAINTplus C-10
Sample database 3-6
  automatic startup and shutdown 3-6
  default account 4-4
  save or discard changes 4-6
  structure 3-6
Sample Menu 3-9
  Login... 3-9, 3-10
  New 3-9
Save sample 3-11
Scale module 3-13
  overview 7-14
Scale Variations plot 7-17
Scaling 7-1, 7-14
Server
  defined 3-1
Shutter
  safety shutter 2-6
  toggling 3-10
Simple Scans 3-3, 5-18
SMART APEX II 1-1, 2-1
  goniometer overview 2-5
Smooth images 6-9
Sort Bin 9-18
Sort Runs for Completeness 6-19
Sorting Atoms in XShell 9-18
Space Group Determination module 3-13, 8-1
Space Groups and Statistics 3-13
Spatial Distribution plots 7-19
Spin files
  importing 3-9
Spin phi 180 5-3
Spin Phi 90 5-3
Spot Position Overlay 7-10
Spot Shape Correlation and Profiles
  in SAINTChart 7-9
Stack Bar 3-15
Status window 3-10
Strategy module 3-12
Strategy view (detailed) 6-21
Structure refinement
  module 3-13
  overview 9-13
Structure Solution module 3-13, 9-1
  overview 9-2
Supercell problems
  in CELL_NOW C-6
Symmetry
  higher symmetry cell search with XPREP 8-2
Systematic absences
  and XPREP 8-3

T
Task Bar 3-7
Task Display Area 3-7
  overview 3-16
Technical Support 1-4, 1-5
Temperature attachments 2-9
Terms and Conventions 1-2
Thermal Ellipsoids
  plots 9-24
APEX2 User Manual Index

Tic Tac Toe 3-14
Timing shutter 2-3, 2-7
Title Bar 3-7, 3-8
Tolerance
  in refinement 6-14
Tool Icon Bar 3-7
Torsion angles
  and CONF card 9-24
Transform Unit Cell module 3-12
Tree View 3-15
T-tool (in Crystal Faces module) B-3
Twinned crystals
  and APEX2 C-10
  and precession images 8-10
  multiple orientation matrices C-10
Typographical Conventions 1-2

U
Unconstrained Unit Cell refinement 7-11, 7-13
Unit Cell Combo Box 6-14
Unit Cell tool
  in RLATT A-16
Unwarp images 3-14
User Manager 3-6

V
Validate
  when preparing an experiment 6-24
Variables in bn-config.py D-1
Video microscope 2-1, 2-7, 5-6
Video zip stream B-2
View Images 3-12
View Molecule 3-13
vzs file B-2

W
Warnings 1-3
defined 1-3
Water ice resolution shells 6-10
Wavelengths for K-alpha 2-6
What’s This? Help 1-4, 3-11
Whole reflections 6-11

X
XCIF 3-14
XL 3-1
XM 3-1
XPRESS 3-1, 8-1
Preparation of an Output File 8-5
X-ray safety issues 1-4
X-ray Source 2-6
XS 3-1
XShell changing displayed atom sizes 9-24
  overview 9-5

Y
YLID test data in this User Manual 1-1

Z
Z values 8-5
Zoom functions 3-11